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Overview

U.C.ME enables you to send alarm notification via: Phone, SMS, WAP, Fax, Email, RSS and
Multimedia. U.C.ME connects to multiple OPC servers and sends alarms in real-time.

U.C.ME enables you to analyze alarms in real-time. At the moment of the alarm, U.C.ME takes a
shapshot of all relevant parameters (tags) and sends them straight to your cell phone, offering you
a complete picture of the system.

U.C.ME enables you to analyze alarms and events from any PC on the Internet or Intranet.
U.C.ME logs all the alarms and events to a relational database that may be viewed using an
Internet browser.

In addition, U.C.ME enables users to perform bi-directional communication with their application
by calling U.C.ME via phone or sending SMS command messages to U.C.ME.

U.C.ME is an event driven and multi-threaded application. It waits for messages coming from the
OPC servers and only then it starts its notification activity.

U.C.ME may dial up to 4 telephone lines concurrently, play voice messages and send fax
documents.

U.C.ME may use a cellular modem to send SMS messages and receive SMS commands.
U.C.ME may send alarms by email to any email recipient.
U.C.ME uses the Dialogic (an Intel company) telephony boards. Dialogic telephony boards are

approved in more than 30 countries all over the world. U.C.ME also uses the Hi-Phone telephony
USB device.



System requirements

U.C.ME has both Software and Hardware minimum system requirements. These requirements
must be met in order for the software to work properly.

Software Requirements

The server requires, at a minimum, the following software:

* Microsoft Windows® 2000 Service Pack 2, Microsoft Windows® XP or Microsoft Windows®
2003 Server.

* Microsoft IIS® server version 5.0 or higher (In case you intend to use the web features of
U.C.ME™),

« Intel/Dialogic drivers SR 6.0 Redistributable Edition

* Internet Explorer 5.0 (in case you intend to use the web features of U.C.ME) or higher.

» Microsoft SQL-Server® 2000 or higher (In case you intend to log your data to MS-SQL
database).

Hardware Requirements

U.C.ME requires, at a minimum, the following hardware:

* Intel Pentium 1lI or better

« 512MB RAM

+ Dialogic telephony board or Way2Call telephony device (Hi-Phone USB) in case you intend to
use the telephony features of U.C.ME.

+ Cellular modem — Siemens (MC35i or TC35i) or Wavecom (Fastrack) and a SIM card (in case
you intend to use the SMS features of U.C.ME)

+ Available serial port for the modem connection (in case you intend to use the SMS features of
U.C.ME)

* Internet connection (in case you intend to use the web features of U.C.ME)

+ Analog modem and a landline telephone for SMS sending using TAP protocol



Installation - Software

Installing U.C.ME™

Insert the U.C.ME CD to the CD-ROM drive. The Setup program should start automatically. However,
depending on your Windows™ settings, the Setup program might not start automatically. In this case, click
on the “Start #” key, select “Run” and type “X:Setup” (where X is your CD-ROM drive letter).

The U.C.ME logo dialog box will appear. Click Next.

{& LLC.ME-OPLC/DDE edition version 5.22 build 500 - Installshield Wiz: x|

U.C.ME

Unified Control MEssaging

TnistallShield

< Bacl

Welcome to the InstallShield Wizard for
U.C.ME-OPC,/DDE edition version 5.22 build 500

The InstallShisld(R) Wizard will install U.C.ME-OPCIDDE edition
wersion 5,22 build 500 on your computer, To continue, click
Mext,

WARNING: This program is protected by copyright law and
international treaties.

Cancel |

< Back

Read the information in the dialog box, and then click Next.



The License agreement dialog box will appear:

{& LL.C.ME-OPC/DDE edition version 5.22 build 500 - Installshield x|
License Agreement ‘
Please read the Following license agreement carefully, i -'.
Licence Agreement d
Read the software li agr t on this sealed package carefully
before opening the package.
By opening the package, you [LICENSEE) accept the TERMS AND
CONDITIONS of the LICENCE.
If you do not accept the TERMS AND CONDITIONS of the LICENCE,
'wou may return this package
unopened and get a full refund.
T e A W Wi el
€ I accept the terms in the license agresment
% 1 do not accept the kerms in the license agresment:
Installstiield
< Back I [ext = I Cancel |

Please read the license agreement carefully and choose between "l accept” or "l do not accept” options. If
you choose "l do not to accept”, the setup program will be aborted. Click Next.
The Readme information dialog box will appear:

{& U.C.ME-OPC /DDE edition version 5.22 huild 500 - Ins le — = ﬂ
Readme Information ‘
Please read the Following readme infarmation carefully. = '

U.C.ME™ - Unified Control MEssaging

1. Installation
Installation sequence
1. Telephony - there are two telephony options:
a. Dialogic PClboard. Install the board and the
drivers. Use SR 5.1.1 feature pack 1 if you are
using Windows P or the D4PCIU or D4RPCIUF

boards
h  Hi-Phnne | I1SE devire  Install the Hi-Phone =l

Instal|shisld

Please read the information carefully and click Next.
The Customer Information dialog box will appear.

{5 U.C.ME-OPC /DDE edition version 5.22 build 500 - Install T x|
Customer Information ‘
FPlease enter your information. = "'
User Name:
|Usarname

Organization:

|Organ|zat|an

Install this application For:
" anyone who uses this computer (all users)
£ Only For me (Micha)

Instzllshisld

< Back I Next » I Cancel |

Enter your name and organization name and select between "Anyone who uses this computer (all users)"
or "Only for me (username)". Click Next.



The Destination folder dialog will appear:

|§a U.C.ME-OPC/DDE edition version 5.22 build 500 - InstallShiel ﬂ

Destination Folder

Click Mext to install ba this Folder, or click Change ko install to & different Folder.

G Install LL.C,ME-OPC/DDE edition version 5.22 build 500 to:

C:\Program Files\Contral-5ee|\UCME-OPC-DDEY Change...

Instzllshisld

< Back Cancel |

Click Next to accept the default folder name, or click Change to select a different folder name.

Click Next. The Ready to Install Program dialog box will appear.

U.C.ME-DPC/DDE edition version 5.22 build 500 - InstallShiel d x|

Ready to Install the Program

The wizard is ready to begin installation.

IF you want to review or change any of vour installation settings, click Back, Click Cancel ko
exit the wizard,

Current Settings:

Setup Type:
Service
Destination Folder:
D\Program FilesiControl-Ses\UCME-OPC-DDEY,

User Information:
Name: Micha
Comparty! Control See Software Solutions Lkd.

Installshisld

< Back

Cancel |

You may review your setup options and click Back to change your settings or Install to continue.
The following dialog box will appear.

U.C.ME-DPC/DDE edition version 5.22 build 500 - InsEalIS| =101 x|

Installing U.C.ME-OPC/DDE edition version 5.22 build 500

The program features you selected are being installed,

Please wait while the Installshield Wizard installs U, C.ME-OPC/DDE edition
wersion 5.2 build 500. This may take several minutes,

Status:

Copying new files

Installshisld

< Back [ext =




Following the file copy process, The Aladdin device driver should be installed. The following dialog box
should appear.

Aladdin Device Driver Installation UEility il

The operation was completed successully.

Click OK to continue. Click on the Finish button. The U.C.ME Application/Service setup dialog box will
appear.

Installing U.C.ME as Windows service

% U.C.ME - Application,/Serrice configuration ) 5'
Ackions

Setup ype Expalanation

™ Standard application]default] LI.C.ME will be installed a5 a standard application.

¥ Service

U.C.ME zervice may depend on other services. Please select the service/s [if any]
that need to run before U_C.ME iz started. For example: Dialogic[w'hen using
Telephony], SAL-5erver or an OPC zerver.

1 dependency services selected,

&  Service name | Dizplay name l;l
O% ClipB ook ClipSry
D% COk+ Event System EventSystem —I
0% Computer Browser Browser
D% CT Bus Eroker CTEusBroker
% DHCP Client Dhcp
% Dialogic Dialogic
D% Dialogic Boardzerver Boardszerver
%4 Dialogic 557 Service Dlge5 7Sy
D% Digtributed Link Tracking Client Trkiw'kz
D{’& Distributed Tranzaction Coordinator MSOTC
M9 DMS Client Dhzzache LI
ok

Select Standard application (default) or Service. If you choose that U.C.ME will be installed as a Windows
service, you may select the dependency services. The dependency services are services that need to be
running before the U.C.ME service is running.

For example: if you are using the Dialogic telephony features, you will need to select the Dialogic service as
a dependency service.

Click OK. The setup process is now completed.

You may later change this configuration by using the U.C.ME Service Configuration program.



Installing U.C.ME as a Windows service has several advantages. First, U.C.ME will be started automatically
after a computer reboot. There is no need to login to start it. Second, users can login and logoff the computer
without interrupting the server. Third, you can setup recovery actions if the service fails, such as restarting
the service automatically or restarting the computer (for computers running Windows 2000 & XP only).

Note: Running U.C.ME as a service is possible only when using an OPC server that also capable to run
as a service.

U.C.ME program folder and shortcut

The setup program creates the U.C.ME program folder, which will include the following items:

'&’ U.C.ME - Waice File Recorder
JiZ.ME - User's Guide

T OULCME - Configuration

2 UWLC.ME - Run-Time

Efr ILC.ME - Send Message

@ Adrrinistr ative Tools »

The Administrative Tools group contains the following items:

L ME - RS - Remoke Upgrade Service
% ILiC,ME - Service Configuration
ﬁj C L ME - Service Manager

In addition, the setup program creates a shortcut to U.C.ME configuration on your desktop (see below).

Configuration




The default U.C.ME folder is C:\Program Files\Control-See\UCME-OPC. You may see the content of each
sub folder in the table below.

Folder name Content

BIN All binary files (EXE, DLL,0CX)

BACKUP Backup ZIP files

HTML Web application (HTML,XML, XHTML, ASP, JPG, GIF)

FTP Web application (HTML, XML, XHTML, ASP, JPG, GIF) — Used
when working with a remote server.

LOG Daily Log files

Email Used as a temporary folder for email sending

WAV_E English voice files - Wave format

WAV_H Hebrew voice files - Wave format

VOX_E English voice files — VOX format

VOX_H Hebrew voice files - VOX format

Pagers Directory Users' definition files

Voice Files - Replies Voice files recorded by users as a reply to alarms

History History files created by U.C.ME for later analysis

SendMessageFiles A folder that holds files used for manual message sending.

EXT_alarms A folder that holds alarm ASCII files created by 3" party programs.

TIMEOUT A folder that holds temporary files for alarms that are defined with
timeout.

Note: At the last step of the U.C.ME setup program, it will invoke the HINSTALL program that will install
the Hasp device driver for the U.C.ME hard-lock key. If for any reason the program didn't run, you may
open a CMD window, switch to the U.C.ME bin folder, and run the program: HINSTALL /i.

For more information regarding hasp drivers see: http://www.ealaddin.com/ .




Installation - Hardware

Installing the Dialogic telephony board

If you intend to use the Dialogic telephony PCI board, install the board in your PC. See more installation
information and instructions in the Dialogic installation guide.

Installing the Dialogic drivers (software)

Note: You must install the Dialogic drivers in any case!

1. Insert the Dialogic drivers CD and run the setup program. If you have a Dialogic board installed, the
setup program may automatically detect it. If not, you should define it using the DCM (Dialogic
Configuration Manager) program.

2. Install the Dialogic drivers as described in the Dialogic installation guide. If have a Dialogic board
installed, make sure that the Dialogic service startup mode is defined as Automatic.

Installing the Way2Call telephony USB device

If you intend to use the Way2Call telephony USB device (Hi-Phone), please use the Way2Call to install the
Hi-Phone drivers. Note: Do not connect the Hi-Phone device to the USB port before installing the drivers!
See more installation information and instructions in the Hi-Phone installation guide.

Installing a cellular modem

If you intend to send SMS messages using a cellular modem, you should have an available COM port in your
computer. U.C.ME uses COM1 to COM10 for modem connection. Insert a CIM card into the modem and
connect it to one of the COM ports.

Testing the modem

If U.C.ME fails to send SMS messages using the modem, you may use the HyperTerminal program to test

the modem connection.

Start the HyperTerminal program (Start@® » Programs » Accessories » Communications

» HyperTerminal) and choose the COM port which the modem is connected to. Use the "9600,N,8,1" port

settings. Type the AT and press Enter. You should get an OK from the modem. If there is no response from
the modem, you should check the possible causes:

1. The modem is connected to the wrong COM port.

2. There is no CIM card inside the modem.

3. The power line is disconnected.

4. The modem is defined as AUTO-BAUD. See the troubleshooting section to see how to change the AUTO-
BAUD to fixed BAUD.



The configuration program

The U.C.ME configuration program enables you to manage your U.C.ME application — alarms, users,

modems, reports etc...

Click on the “Start@ P Programs P Control-See » U.C.ME-OPC P> Configuration” menu item to start

the configuration program.

The following window will be displayed. You may use the toolbar to easily navigate between the most

commonly used windows. To access other windows, use the U.C.ME menu.

Configuration - U.C.ME-OPC [Server=http:/ /localhost/UCME-OPL ] 1
File Logfiles Design Options Wiew Tools Help

Run-Tirne!

AclA

i

Button

Functionality

Button

Functionality

View - Browse Alarm
Snapshots

i

Design Recipients

Design - Record and Play
Wave Voice Files

Options - Settings

Design - Weekly Shifts

Design Special Days

3 Design Alarms Invoke the Send-Message
| S | = utility
Design Incoming Phone calls @ Logout
Design Incoming SMS fb Login
commands
Design Groups Exit




The Options menu

Dialogic telephone lines settings

Use the following window to define which of the 4 Dialogic channels is connected to a telephone line. The
following window will be displayed:

®iaLine settings - x|
~Line 1 ~Line 3
@ Dutgong calls " Outgoing calls
" Dizabled ' Incoming calls
* Dizabled
~Line 2

~Line 4
' Outgoing calls

" Dutgaing calls

™ |ncoming calls
{+ Dizabled f* Dizabled

Save | LCancel |

Depending on the Dialogic board that you are using, you may define the use of the available phone lines.

In case a telephone is connected and in use, set the “Outgoing calls” field. If the line is not in use set it to
“Disabled”.

Note: You may define line 2 or 3 for “Incoming calls”. However, a line may be used exclusively for
"Outgoing calls" or exclusively for "Incoming calls".

Note: if you are using the Hi-Phone telephony device, you must disable all Dialogic lines.




SMS protocols

Use the following window to define the SMS protocols that you wish to use (depending on your SMS
providers). U.C.ME may handle few SMS protocols concurrently. Each SMS protocol is handled in a
separate thread, so that messages may be sent to different recipients at the same time.

&7 5M5 protocols ) x|

&dd

Delete

Save | Cancel |

Click on the "Add" or "Delete" button to add or delete an SMS protocol. When clicking on the "Add" button or
when double-clicking on an existing protocol, the following window will be opened.

%
Paging system
IGSM-Modem j Diefaults for GSM-todem |

Part narne : m Phone number . {935

Baudrate : Im [T Leasedline

Diata bits m v Use part for incoming SMS messages
Stop hits : Iﬁ

Farity : Mo -

Diata Coding Schem | PDU-7it =l

oK [ LCancel

Choose the Paging system from the list. Set the appropriate values for the fields:

Port Name — (COM1, COM2, etc...), Baud rate, Data bits, Stop bits, Parity, Phone number etc...

Click on the "Defaults for...." button to set the default settings for the specific paging system.

When using the GSM-SMS protocol, you may use this protocol for incoming SMS as well. In this case, you
should set the "Use port for incoming SMS messages" parameter.




The GSM-Modem protocol (PDU mode)

The GSM-Modem protocol may be used to send and receive SMS messages (TEXT messaging) using a
cellular GSM modems. The advantage of using a cellular modem is that you don't need internet connection
and the Email-to-SMS service to send SMS messages. This protocol utilizes the GSM cellular modem in
PDU mode.

Tested and approved GSM modems

The modems that were tested and verified for use with U.C.ME are:

¢ Wavecom - Fastrack (GSM)
¢ Siemens - MC35/TC35 (GSM)

These modems require a SIM card installed and a free serial COM port to connect to.

The TAP protocol

The TAP Protocol allows you to send SMS Messages using a Standard Data Modem and Telephone
Landline. For a detailed list of TAP providers, click on the following button.

P Wiew TAP providers. . ;

Note: Each service provider (i.e.: Verizon, Sprint, SkyTel. etc...) sets the number of messages you may
deliver in one call. Please check with your provider regarding this parameter and set it in U.C.ME.

The Cellular-Text protocol (TEXT mode)

The Cellular-TEXT protocol may be used to send and receive SMS messages (TEXT messaging) using a
cellular GSM and CDMA modems. The advantage of using a cellular modem is that you don't need internet
connection and the Email-to-SMS service to send SMS messages. This protocol utilizes the GSM and the
CDMA cellular modems in Text mode.

Tested and approved modems using TEXT mode

The modems that were tested and verified for use with U.C.ME are:

¢ Wavecom - Fastrack
e Siemens - MC35/TC35




Settings

The settings window enables you to set various U.C.ME settings. Switch between the different tabs to
change the settings.

General
% Settings ) x|
( Alarmz - ASCI file interface T Language tranzlations T [Databaze
f OFC/DDE T Alarm Snapshot T t aster - Standby
[ SM3 i Fax i Emai
[ Loa fil Il Veice fles | Multimedia
Telephony T i I T Tags

IV witite activity to log file v Display activity in listbox

[~ Save alamns to history files

[~ Sort dialing list according to priorities
WWait until Dialogic drivers are lnaded IEI secands

[+ Flay current item value befare wiiting new walue (incoming and outgaing calls)

¥ Use Family alarm templates

[~ Add voice time stamp to each alarm

Languane ILeft_TU_Flight L‘ YWeek starts at IMnnday "I

[~ Cloge U.C.ME on OPC/DDE server dizconnection

Alarm date format Iddr’mmr’_l,l_l,l j

[~ Save acknowledge information to the database

M Write activity to log file

Use this option to instruct U.C.ME to write all its activity to a log file. If this option is set, U.C.ME will write
all the activity to a log file named: UCMEyyyymmdd.LOG (where yyyy is the year, mm is the month and
dd is the day of month). This file may be viewed or printed at any time. You may use this log file to
analyze U.C.ME activity, or to find the cause for any software error or problem. Don’t forget to delete this
file from time to time.

M Display activity in list-box
If you wish to display U.C.ME activities in the U.C.ME main window, set this field. In this case U.C.ME will
display a circular list of the last 1,000 activities in its main window.

M Save alarms to history files
If defined, U.C.ME will save all alarms to history files. These file can be used for report generation.



M Sort Dialing List according to priorities
Set this field if you want that U.C.ME will sort the alarms’ dialing list according to each person’s priority. If
this field is not set, U.C.ME will dial according to the dialing list order.

M Play current item value before writing new value

Set this option if you want that U.C.ME will play current value before it let you change its value. For
example, if you define an action - "Set interactive tag value", you may want to listen to the current value
before you change it.

M Use Family for Alarm templates

Set this option if you want that U.C.ME will use Family alarm templates. The use of alarm templates
eases the definition of multiple alarms that are different only in their voice file name. All other settings are
the same.

M Add voice time-stamp to each alarm

This feature is applicable for phone/voice alarms only. When it is in use, U.C.ME will play the alarm's time-
stamp before playing the alarm message. For example: "Alarm started at 12 and 35 minutes — Fire alarm 2m
floor ...."

M Language type
Use this feature to set the language type: "Left_To_Right" or "Right_To_Left". "Right_To_Left" may be used
with languages like Arabic and Hebrew.

M Week starts at
Use "Sunday" or "Monday" as the first day of the week

M Alarm date format
Select a date format in which the alarms' date will be displayed. The following formats are available:

= dd/mm/yy

= dd/mm/yyyy
=  mm/dd/yy

=  mm/dd/yyyy
= dd/mm

= mm/dd

=  dd.mm.yy

=  dd.mm.yyyy
= mm.dd.yy

=  mm.dd.yyyy
= dd.mm

* mm.dd

M Save acknowledge information into the SQL database
Set this property to instruct U.C.ME to add a record into the SQL database containing the acknowledge
information — Alarm text and the name of the user who acknowledged the alarm.



Telephony

4 settings X|
|/ Alarmsz - ASCH file interface T Language tranzlations T Databaze
( OFC/DDE T Alarm Snapshot T tdaster - Standby
[ 5MS il Fan I Email
[ Log fil | Voice files | Mulimedia )

T General T Tags

¥ Enable Telephony

Telephony type
% |ntel/Dialogic

= Way2Call [Hi-Phaone)

 auimum zilence interval before hangup |4— zeconds

t axirumn number of ringz before hangup Ig— fings
Murnber of rings before "Call Analyziz" beging |1— fings

Delay after dialing before “Call Analpsis” beging 250 mili seconds

Dialing gystem : ITDne "I Defaults
Dialing prefis : I

[~ Dwal tone spstem

M Enable Telephony
Click to enable/disable Telephony features

M Telephony type
Choose between Dialogic and Hi-Phone. Note that with Hi-Phone you can only use one telephone line and
for outgoing calls only. Hi-Phone telephony is limited to:

= Getting password via DTMF

= Playing wave files

= Alarm acknowledge

= End of call verification

M Maximum silence interval before hang-up
This field defines the maximum silence time interval (in seconds).
When U.C.ME reaches this time interval, it will terminate the call

M Maximum number of rings before hang-up
This field defines the maximum number of rings before hang-up.
When U.C.ME reaches this number it will terminate the call.

M Number of rings before “Call Analysis” begins
U.C.ME is using a sophisticated “Call Progress Analysis” procedure. This procedure identifies when the
call is answered, and when the call receiver speaks to his phone (Hello...).



You may set the number of rings before the “Call Analysis” begins. This may be used in cases where you
dial to telephone (especially mobile) which does not enable you to hear the first ring. In this case you
should set value of this field to “2”. The default value for this field is “1”.

M Delay after dialing before “Call Analysis” begins

This parameter is also used for the “Call Progress Analysis” procedure.

The default value for this field is “250” (0.25 second). If you specify greater values, U.C.ME will ignore
noises until the end of the delay time.

M Dialing System
Set this field to “Tone” or “Pulse” according to your telephone line type.

Note:
U.C.ME can dial out either using “Tone” or “Pulse”, but,
U.C.ME can’t get DTMF tones from a telephone, which operates in “Pulse” mode!

M Dialing Prefix
If U.C.ME uses a line that is connected to a switchboard, type the dialing prefix. For example: “9”. This
prefix number will be added to all of the telephone numbers, which are defined in your phone book.

Note:
If you are dialing to internal telephone numbers which doesn’t require the prefix number, leave the
“Dialing Prefix” field empty, and add the “Dialing Prefix” to each external phone number in your
phone book.

M Dual Tone system
Use this option if you are using U.C.ME in a country with dual tone telephony system. (For example:
Australia, UK)



|/ Alarms - ASCH file interface T Language tranzlations T Database 1
( OPC/DDE T Alarm Snapshot T Mazter - Standby ]
( SMS il Fan | Email i
[ Loa fil | Voice fles i Mulimedia )
T elephaony T General T g M Tags
Tag time format; IMinutes_since_DD:DD j

[w “adite 1" ta tag when magsinum dialing reties is reached

Server IMatrikan.DF‘E.SimuIatiDn.'l j Tag IEucketErigade.Int‘l

[ wiite handshake values o kag

Server IMatrikun.DPC.SimuIatinn.1 j Tag IBucketBrigade.Int2

[ “wiite activity to sting tag

Server IMatriku:nn.ElF'E.SimuIatinn.1 j Tag IBucketBrigade.Stling

¥ Enable/Disable alam notification tag

oL L Lk

Server IMatrikun.DF‘C.SimuIatinnJ j Tag |BucketBrigade.BonIean

v Delete all alarms from queue tag

Server IFactDlySth.SampIe.'l j Tag IDEViCE'I.GrDup'l.Tag'l

Select an OPC server and then press on the browse button to select a tag name.

M Tag time format
Set this field to “Seconds_since_00:00” or to “Minutes_since_00:00" according to the format which is used in
your SCADA application.

M Write "1" to tag when maximum dialing retries is reached
Use this option to instruct U.C.ME to write the value "1" to a tag to indicate that maximum dialing retries
has been reached.

M Write handshake values to tag

Use this option to instruct U.C.ME to write values to a tag. This option may be used if you want to verify
(in your SCADA application) that U.C.ME is up and running. If set, U.C.ME will write the seconds of the
hour every 20 seconds to tag defined in this field.

M Write activity to string tag
Use this option to instruct U.C.ME to write all its activity to a string tag.

M Enable/Disable alarm notification tag

Use this option to enable/disable the alarm notification by changing a tag value within your SCADA
application. Assign the value of "1" to disable alarm notification. Assign the value of "0" to enable alarm
notification.



M Delete all alarms from queue
Use this option to delete all alarms from U.C.ME's queue by changing a tag value within your SCADA
application. Assign the value of "1" to force alarm deletion. The value will be set to "0" after alarm deletion.



Log file

% Settings 2 =
[ Telephaony T General T Tags
|/ Alarmz - ASCI file interface T Language translations T Database
( OPC/DDE T Alarm Snapshot T Master - Standby
[ SMS i Faw 1 Email
1 Voice files 1 Multimedia

B LH E
rdrite to log file
Use Default |

v General information
¥ Emors
¥ Debug information

V¥ “Wamings

Laq files folder ID:\F‘loglam Files\Control-5eetlJCME-OPC-DDE 5.64ag

L

Log Viewer I

Set each type of information you wish to be written to the log file:

M General information (recommended)

M Errors (recommended)

M Debug information - setting this option will instruct U.C.ME to write additional information that may be M
unclear to the common user. Use this option only if you are facing problems and want to investigate it via the
log file.

M Warnings (recommended)

U.C.ME's log file name is "UCMEyyyymmdd.log" (where yyyy is the year, mm is the month and dd is the
day). It can be viewed with any text editor. In addition you may view the file U.C.ME errors file named "UCME
errors.txt".

These log files can be also viewed from U.C.ME's run-time and configuration modules.

Log Files Folder - The default folder for U.C.ME log files is: C:\Program Files\Control-See\UCME-
OPC\LOG. You may change this folder by setting a different folder path. You may use the Browse button to
browse for a folder.

Log Viewer - The default log file viewer program is Lister.exe. Leave this field empty to use the default
viewer. To select a different viewer, click on the Browse button and select another viewer program. For
example: Notepad or TextPad.



Voice files

|/ Telephaony T General ]_T Tags

|/ Alarms - ASCH file interface T Language translations
( OFC/DDE T Alarm Snapzhot T Mazter - Standby T
[ SMS [ Fax [ Email
Log fil | : 1 Mulimedia

Voice files format————
[CIRYYAY)
WO

Yoice files path ID:\F'n:ugrarn FileshControl-5eehJCME-OPC-DDE 4.4%wi4W H |

M Voice Files Path - This field defines the directory in which all of the VOX or WAV files are located.
The default path for the U.C.ME voice files is:
"C:\Program Files\Control-See\UCME-OPC\WAV_E" (E - English, H - Hebrew)

M Voice File format

Choose the voice file format you prefer: VOX or WAV. VOX is a dialogic standard while WAV is a Microsoft
Windows standard. WAV file format enables you to use standard recording and playback utilities and thus,
the recording and playback is much easier. In addition, U.C.ME's configuration program contains built-in
playback and recording functions that are supported for WAV file format only.

When working with the WAV format, make sure you record files with the following properties:

WAV Audio format: PCM 11.025 kHz, 8 bit, Mono.

Improving WAV files quality
Recording with Microsoft Windows® Sound recorder utility, you may change the audio properties to improve
WAV file quality. Click on Edit » Audio properties. The following window will be displayed:

Audio Properties e
Audio Devices |
~ Sound Playback,
@'\/ Preferred device:
Soundkax Digital Audio -
alume Advanced
 Sound Recarding
Preferred device:
[ SounaMex Dighal Audie i
Yolume Advanced
 MIDI Music Plapback
% Preferred device:
<22 [ SounaMes wDM MIDI i
olume: Sbout
[~ Use only preferred devices

ag I Cancel | Spply |




Click on the Volume button inside the "Sound Recording" frame. The following window will be displayed:

EE Recording Control ]
Options  Help
CD Player Microphone Line In
Balance: Balance: Balance:
Yolume: Yolume: Wolume:
[ Select ¥ Select [ Select
Advanced |
|SoundmMAx Digital Audic

Set the volume to the maximum. In addition you may click on the "Advanced" button. The following window
will be displayed:

Advanced Controls for Microphone x|

Theze settings can be used to make fine adiustments to your
|" audio.

r~ Tane Contral

Theze settings contral how the tone of your audio sounds.

Bass: Loy J— High

Treble: Law J— Hiagt

- Other Control

Theze settings make other changes ta how pour sudio sounds. See
your hardware documentation for details.

¥ 1 Microphone Boost
I~ 2 Front Panel Microphane

Close

Set the "Microphone Boost" to improve the volume of your recorded voice files.



Multimedia

* Settings x|
( Telephony T General T Tag:
f Alarms - ASCI file interface T Language translations T Database
[ OFC/DDE T Alarm Snapshat T M azter - Standby
[ SMS Il Fax | Ernai
Log file | Voice fies | _ Multimedia '
¥ Play alams ta local loudspeakers @:
Contral tag

EL-I0T N £11 atrikoon, O PC., Sirulation. 1 Enable/Dizable alarm replay |

L

Semer IMatriknn.DF'E.SimuIation.'l j Stop replay, delete all alarms I

Delay between replap(mil second] {5000
Replay count |5—

¥ Add alamn bime stamp

[~ Play ended alarmns

¥ Play "Mew alam' meszage

M Play alarms to local loudspeakers - set to enable alarm playing to your local loudspeakers.

M Control Tags

Optional tag names that can be used to control U.C.ME alarm playing via the SCADA application or OPC
server.

Enable/disable alarm replay — if the tag value is 1, the alarm replay is disabled. If 0, alarms will be played.

Stop replay, delete all alarms — if the tag value is 1, all alarms will be deleted from the wav replay queue.

M Delay between replay — Enter delay time (in milliseconds) between each wav file replay.

M Replay count — Enter replay count for the alarm. For example, if set to "5". The alarm will be played 5
times. Set to -1 to replay forever.

M Add Alarm timestamp — set to instruct U.C.ME to play the alarm's timestamp. (HH:MM)

M Play Ended alarms — set to instruct U.C.ME to play the alarm's wav file name also when alarm is ended.
In this case the alarm will be played only once. For example: "Alarm ended — Fire alarm 2" floor".

M Play "New alarm™ message — set to instruct U.C.ME to play the "New alarm" message each time a new
alarm is created. This message will be played only at the first occurrence of the alarm.



[ Log fil | Woice files il Mulimedia i
[ Telephony T General Tags ]
( Alarmz - ASCI file interface T Language translations ]_T
[ OPC/DDE T Alarm Snapshat T I aster - Standby "
SMS | Fan b Email '

¥ Enable Email sending

b zil zerver |mai|.m_l,lsewer.con']

"From'" email address IEmaiI@LIEM E alarmz. com

Ll Snhapshat attachment lype——

|25
Timeout |4UUU mili-seconds ~ Test
e

-mail i |1EIDEI
E-rnail size bytes & HTML
I ax retries !3

[~ Add "Alam started/dlarm ended" prefix text to the email's Subject
[ Add ‘Alam ID' to the email's Subject

Log messages IEHD[S_. warnings, info, debug ;I

Restore Defaults |

M Enable Email sending Set to enable Email sending. Make sure that you use the "Outgoing server"
address and not the "Incoming server" address. You may look at your MS Outlook mail definitions to see
what the outgoing server address is.

M From email address
This name will be displayed in the email "From" field when receiving emails from U.C.ME.

M Port — Define the port address. In most case it should be 25.
M Timeout — Define the timeout (in milliseconds) in which the email thread will check for new emails.
M Email size — Define the email max size (in bytes). In most cases 1,000 is sufficient.

M Max retries — Define the maximum number of retries in which U.C.ME will try to resend an email in case
of an error.

M Add the "Alarm started/Alarm ended" prefix to the e-mail's subject
Set this field if you wish to add the "Alarm started" or "Alarm ended" prefix text to the e-mail's subject.

M Add Alarm-ID to the e-mail's subject - Set this field to add the alarm's ID to the e-mail's subject.

M Log messages — Define which type of information will be written to the email thread log file. The log file
name is "SendEMail.log".

M Snapshot attachment type — Define the type of attachment (HTML or Text) that U.C.ME should use
when sending emails.



Fax

[ Settings x|

[ Log file | Voice files Il Mulimedia |
[ Telephony T General T Tags

SMS Il @ 1 Ernail

¥ Enable Fax sending

Laocal ID |Cu:untn:u|-5 gE

Ilzer Header figld |FaH frorm Control-See Lid.

M Enable Fax sending - Set to enable Fax sending. Note that fax sending requires a Dialogic board that
supports fax (For example D/4PCIUF).

M Local ID - this is the string that will be displayed in the receiving fax display.

M User Header — this text will be printed at the top of the fax page.



[ Log fil | Voice files | Mulimedia
( Telephaorny T General Tags
|/ Alarmz - ASCI filz interface T Language translations ]_T
f OPC/DDE T Alarm Snapzhat T Maszter - Standby ]

T Fax T Email

v Add alarm time and date to message

[" Send feedback message to users after ‘Bcknowledge’ commands
[~ Add “&lamm started/ended" text prefis bo the SMS/Pager message
[~ Add 'alam D' to enable alam acknowledge

M Enable SMS sending - set to enable SMS sending.

M Add alarm time to message — when set, the alarm time will be added to the SMS message. When set,
the date format should be selected.

M Send feedback message to users after acknowledge commands — when set, U.C.ME will send
feedback message to users who will perform acknowledge commands via SMS. When a feedback SMS
message is received, the user can be assured that his acknowledge command was executed successfully.
When set, the following texts should be translated to your local language: "Done", "Failed", "The value is".

M Add the "Alarm started/Alarm ended" prefix text to the SMS text — when set, U.C.ME will add the
"Alarm started" or "Alarm ended" SMS text. When set, the following texts should be translated to your local
language: "Alarm started", "Alarm ended".

M Add "Alarm ID" to enable alarm acknowledge — when set, U.C.ME will add the alarm ID to the SMS
text. This ID will allow users who receive alarms via SMS to acknowledge the alarms.



OPC/DDE

0 settings i x|
[ 53 | Fax 1 Email i
[ Log fil i Voice files | Multimedia )
|/ T elephorny T General T Tags
[ Alarmsz - ASCI file interface T Language translations T Databaze ]
OPC/DDE T Alarm Snapshat T M azter - Standby

i+ OPC

Server name IFactDr_l,lSth.SampIe.'l | Computer narme I

Update rate |'| 000 miliseconds Initialization timeout IBU seconds

Logical Mame IFactDr_l,l-Sewer

Log messages IErrorS, warhings, info, debug j

Server Mame

] A 0k o amp 3 Add

Simulation-Server M atrikon. OPC. Simulation. 1
Change
Delete |

4| | B

" DDE
ApplicationdServer IWIZEDN
Tapic |GATE

Connection Name IWIZEDN —

[~ DDE request upon initialization

Mo server

Save | LCancel |

You may choose between "OPC server"”, "DDE server" or "No server". When choosing OPC, you may use
the browse button to select an OPC server name. Define "No Server" when using a 3¢ party program that
creates alarms using the ASCII file interface.

M OPC

Server name - OPC server name. Use the browse button to browse for OPC servers.

Update rate — the minimal time (in milliseconds) that passes between U.C.ME will get new updates from the
OPC server. The default value is 1,000.

Log messages — Select the OPC thread's log options. The log file name is OAI.LLOG.



Initialization timeout — (in seconds): At startup, U.C.ME creates the connection with the OPC server. The
initialization time may be influenced by various parameters: The amount of alarms defined in U.C.ME, the
OPC server and the communication performance between the OPC server and the PLC/s. U.C.ME enables
the user to set different initialization time to prevent initialization timeout errors.

Computer name — The computer name on which the OPC server is running on. Note that if the OPC server
is running on a different computer, you need to use the DCOM configuration program to configure security
settings that will enable U.C.ME to communicate with this server.

Logical name — A name that identifies the OPC server. Note that the logical name has to be unique for each
OPC server.



Browsing OPC servers

Click on the Browse button. The following window will be displayed:

OPC Servers

o] S MICHALY
ﬂﬂ eMation Wizcon OPC Server

----- ﬂﬁ Factory3oft Modbus OPC Sample

i-=mE Matrikon OPC Server for Simulation and Testing

ﬂﬂ OPCDataCkrl OPCSimServer

e =58 SMNMP-OPC Server 3.0
.. My Metwark Places

Ok LCancel |

Choose one of the servers. Its name will be displayed in the server name field.

M DDE

Application/Server — DDE server name (See the table below).
Topic — DDE topic name (See the table below).

Connection hame — select a name for the Application/Topic.

DDE Application/Topic hames

Software Application Topic
Cimplicity CWSERV Point
CiTect CITECT VARIABLE
Excel EXCEL Book1.xls
InTouch VIEW TAGNAME
iFIX DMDDE DATA
PCIM DBSR PCIM
Vuniq VuServer DataTable
Wizcon WIZCON GATE

M No server - Choose No Server if you are not connecting to an OPC or DDE server.




Master-Standby application

-4 Settings |
[ SMS | Fan | Email
[ Log fil It Voice files | Mullimedia
( Telephony T General T Tags
[ Alarmsz - A5 fle interface T Language translations T D atabase i
OPC/DDE T Alarm Snapshot T ':I Master - Standby
=]
v Master/Standby application =
Type of use
= Master
{* Standby

Swnchronization tag name |

Server

Fleaze note, M azter-Standby application requires wa U.C.ME spstesm running on bwo PCs.
U.C.ME uzes atag to spnchronize between the master and standby stations.

U.C.ME support master-standby application. A master-standby application contains 2 computers on the
same network, when each computer is running U.C.ME. Use the screen above to define the functionality of
each station — "Master" or "Standby". A "Standby" station will work in passive mode while the "Master" station
is working. When the "Master" station is unavailable, the "Standby" station will take control and will start the
alarm notification process.

M Synchronization tag name — A valid tag name that exist in your OPC server or SCADA application. The
same tag name should be defined both in the Master and the Standby stations.



Alarm Snapshot

[ SMS | Fa il Email )
[ Loa fil | Voice files I Mulimedia
( T elephary T General Tagz
( Alarmz - A5C| file interface T Language translations ]_T
OPC/DDE | : 1 Master - Standby i
“web Snapshots
v Enable web snapshaots List of BSS readers
HTMLA=ML Falder |d:\F'rogram Files\Contral-Seet JCME-OPC-DDE 4. 45\HTML _I
HTMLAML URL [http: #localhost/UCME-OPC/
Title |New ‘fork Hotel - BMS LRL Link |http:/Alocalhost/UCME -OFC/read_db.as
Diezcription IU.C.ME - Advanced Alarm Snapshot

Logo image LURL |http:.-‘f'lou:alhost.leI:ME-DF'D'uc:me_Ingu:u_Small.gif
Loga Image width I?U Loga image height |35

Log file IError&, warhings, info, debug j

[~ Use FTF for remate web server

rCellular Snapzhots
¥ Enable Cellular snapshots

¥ Enable FTF
FTP server Iftp.cnntrulsee.com
: Llzer: I j
[ Use PIMG to improve performance

FTP username ISr1a|:|$|*1|3l.‘>§:>ﬂ:?< FTF pazzward I’“‘“"’“‘ i

Clear snapshat history...

[ Send emars via SM5

U.C.ME enables you to record alarm and event snapshots each time an alarm or event is triggered.

When alarms or event occurs, U.C.ME performs a snapshot of up to twenty tag values that are related to the
alarm.

The snapshot may be sent to your cell-phone, viewed in an RSS reader or in a standard Internet explorer.

1 Enable Web Snapshots
Click to enable/disable the Web Snapshot. When this parameter is set, U.C.ME will add each alarm to a
database and will create HTML/XML files that will allow users to view alarm information through the web.

Note: To use the Alarm Snapshots, Microsoft IS must be installed. A virtual directory called UCME-OPC
is automatically created by the setup program.

M HTML/XML folder
Define the folder name in which U.C.ME will create the XML/HTML files. The default value for this parameter
is: "C:\Program Files\Control-See\UCME-OPC\HTML".



M HTML/XML URL - Define the URL name. (i.e.: http:/localhost/UCME-OPC ).

M Title - Define the title that will be displayed in the web pages. i.e.: "Alarm History".
M URL link - This link will be used by the RSS reader software. This link may lead to any web page.

M Description - Define the description that will be displayed in the web pages. i.e.: "U.C.ME — Advanced
Alarm Snapshot".

M Logo image URL - Some RSS readers enable to display a small GIFF image. This image also serves as
a link to the URL link (see above).

M Logo image width and height - Define the logo image width and height.

M Log file options - Define the log options. Use debug only when you wish to track and analyse a problem.
The log file name is AMI.LOG.

V] Use FTP for remote web server - In case your web server is located on a remote server, set this
parameter and define the FTP settings (see below).

[ Enable Cellular Snapshots - Set this parameter if you wish that U.C.ME will create cellular snapshots. If
set, U.C.ME will create XHTML files that will be transferred to the remote FTP site (see below FTP

definitions).

] Enable FTP - Set this parameter if you wish that U.C.ME will use FTP to transfer the appropriate files to a
remote FTP server.

FTP settings
M FTP server - Set the FTP server address. For example: ftp.mysite.com .

[ Use PING to improve performance - To improve FTP performance, you may set this parameter. If your
FTP server doesn't support PING, don't use this option.

M FTP username and password - Set the FTP username and password.

[ Send errors via SMS - In case of errors connecting the FTP server, U.C.ME may send an SMS to the
selected user.


ftp://ftp.mysite.com/
http://localhost/UCME-OPC

M Clear snapshot history

Clear Hiztary. ..

You may delete alarm snapshot history from time to time. Select the date range and the categories you wish
to delete and click on the "OK" button. U.C.ME will delete the appropriate records from the database and all
the related files.

Note: All "Category" fields must be provided. Use the Category buttons to select a category or sub-
category, or type * to delete all the records of the category/sub-category. For example when using
Category=""", Sub-Category1="Pumps" and Sub-Category2="*", all records with Sub-Category1="Pumps"
will be deleted.

Advanced Alarm Snapshot - Delete history '
Diate range Frari; I_','_','_','_I,I.-"mm.-"dd _I To I_I,I_I,I_I,I_I,I.-"mm.-"dd

Category I Category...
Sub-cateqary 1 I Sub-categary 1...
Sub-categorny 2 I Sub-categomny 2.

ok Cancel |




Alarms - ASCII file interface

[z Settings j il
[ OPC/DDE T Alarm Shapshot T M aster - Standby
[ G 1 Fan )i Emai
[ Log fil i Yoice files 1 Mulimedia
[ Telephory T General Tags
Alarms - ASCI file interface! | Language translations ]J

¥ Enahle &5C1 il interface

Check for new alarm fles every |1 oo miliseconds

M Enable ASCII file interface

U.C.ME enables other applications to generate alarms. The other application should create the alarms in
ASCII files that are placed on the hard disk. The files should be created in the "EXT_alarms" folder (For
example: "C:\Program Files\Control-See\UCME-OPC\EXT_alarms").

Set this parameter if you wish to activate the external alarms thread.

M Check for new alarm files every ___ milliseconds
Set the timeout (in milliseconds) in which U.C.ME will check for new alarm files.



Language translations

| | Elephomy | laErneral | | ags

&larms - ASCI file interface T ‘Language translations T D atabaze

~Tranzlate the fallowing tests to your language

Done' IDDHE
Failed' IFaiIed

The value iz' IThe value iz

"larm Started' |.-5'-.Iarm started

"&larm E nded' |.-5'-.Iarm ended

"Blarm Acknowledge' |.-5'-.Iarm Acknowledged
‘Required' IHequired

"0t of range’ IDut af range

U.C.ME enables users to translate various texts to any language. These texts are used by U.C.ME when
sending messages or when storing data into the database.



Database

P 1 ——————— 1 PR

Alarmsz - A5CI file interface T Language tranzlations T D atabase ]

rDatabaze type
= Microsoft Access

f* Microsoft SOL

rSOL server zetting

Usermame Isa
Pazgword I
Diata zource IMYEDMF‘LITEFH

U.C.ME enables users to choose which database they want to use when storing alarm information.
The supported databases are:
= MS-Access
= MS-SQL Server
MS-Access may be used in smaller applications with small amount of data. MS-SQL Server may be used in
larger applications with large amount of data.

Note: MS-SQL Server is not supplied and installed with U.C.ME. You have to purchase it and install it
separately.

SQL-Server settings
M Username — Username as defined in MS-SQL Server.
M Password — Password as defined in MS-SQL Server.

[ Data source — computer name. U.C.ME may write its data to a database located on the local computer
or to a remote computer.




Defining the U.C.ME database in SQL-Server

U.C.ME installs the database file into the HTML folder (usually C:\Program Files\Control-See\U.C.ME-
OPC\HTML). The database files are AllAlarms.mdf and AllAlarms.Idf.

To define the database in SQL-Server, start SQL-Server's Enterprise Manager program. Open the

database tree and right click on the mouse button and click on the "All Tasks» Attach Database..." menu
item. The following window will be displayed:

Attach Database - {local) x|

MDF file of databaze to attach:
I | Werify |

Original File M arme[z] | Current File[z] Location |

1 | 2

Attach as: I

Specify database cwner: [MICHAT\USR_MICHAT |

[k Cancel Help |

Click on the browse button (...) and select the AllAlarms.mdf file. Click on the OK button.
You should see the AllAlarms database in the Database sub tree.

':m Console Root'Microsoft SQL Servers'\SOL Server Group'{local) {Windows NT}\Databases' Allalarms = |EI|1|

| action  view ook |J<2=-D||X|@ |2k N|Br B BBGG |

Tree I Alldlarms 10 Ikems
(1 Console Root = = E EFEI"" @ D lj
E|-- Microsoft SOL Servers = ]

Eﬁ SCL Server Group Diagrams Tables Views Stored Users Rales Rules Defaults

EI& {local) (windows MT) Pracedures

EID Databases
B0 | &

=3 D =] o

iagrams
9 Tables it
" Views B

-l Stored Procedures
17 Users
-5 Roles
----- =] rules

--[=] Defaults

% User Defined Data Typ
. User Defined Function:

raster

model

msdb

Marthwind

pubs

-k tempdb

#-{_1] Data Transformation Services

¢-{_7] Management

7-_7] Replication —

b1 Security

H-_7] Suppaort Services =
T e e~ p)
i | _>l_I

0 O o O B e




Defining the default user in SQL-Server

In order to view the database content using an Internet explorer, you must define the default user. The
default user name should be IUSR_XXXX where XXXX is the computer name (data source).
Make sure that this user has the db_datareader and db_datawriter permissions (see below).

Database User Properties - IUSR_MICHAL ] x|

General |

Lagin name: MICHATMUSR_MICHAT

Uzer name: IUSE_MICHAT

[atabaze role membership:

|F'ermit in Databaze Role - |

db_owrer

db_accessadmin
db_zecuritpadmin
db_ddladmin
db_backupoperator
I db_datareader
T db_datawriter

] db_denypdatareader
1 db_denypdatawriter

oo

Properties. .. |

QK Cancel Spply | Help |




The Design menu

Recipients - Phone Book

Use the Recipients Phone book window to manage alarm recipients. In this phone book you may define
recipients' names, phone numbers, email address etc...
The following window will be displayed:

¥ Recipients - Phone book g x|
Edit
Fiecipient I Suzpenzion [ntervalmm-dd-yppy) I Fhaone number/E mail I Fazzward Fagin
O&o0avidG. 2127643687 123 Phaoru
O 3 MakB 818643580755 rull SMS Mew
O Mike 04-12-2006 00:00 to 05-31-2006 08:00 7496563 rull Fax
HE gl Edit
O g Mik. 04-11-2006 00:00 to 05-11-2006 00:00 972546242622 il SMS =
O Mike micham(@controlse.. null Ermnail
O ; Paul 2187778080 null ShS Delete
HTML report
| | i
7 recipients defined
Save [ Find Recipient Fitnd text | Cancel [
Note:
You can not change the name of existing user. A user name may appear in alarms and groups.
Changing its name may cause errors when searching for non-existing users.




The Phone book menu

To access the phone book menu, point the mouse over the recipients list and click on the mouse right
button. Alternatively, you may click on the Edit menu on the top left corner of the phone book window. The
following menu will be displayed:

Mew Recipient. .. kel
Edit Recipient

Copy Recipient k|4
Paste Recipient Zhrl+
Find... Zkrl+F
Find Mext F3
Delete Recipient Dl

Select all Recipients
IInselect all Recipients

Suspend Recipient
Resume Recipient

Click on the required menu item to perform any of the operations.

Deleting recipients
When deleting a recipient, the following message will be displayed:

Delete from all alerts? x|

@ Delete 'David@sMs' Fram all alarms and groups?

Ves Mo Cancel |

If you click on the "Yes" button, the recipient (in this example - "Ben") will be deleted from all
alarms and groups when saving the phonebook. Clicking on "No" will delete the recipient but
will keep its name in all alarms and groups. Clicking on "Cancel" will keep the user in the
phone book and in all alarms and groups.

Adding new recipients

Click on the "New Ctrl+N" menu to add a new recipient. Double click on an existing recipient to change its
properties.

Use the "Copy Recipient Ctrl+C" and "Paste Ctrl+V" menu items to create new users based on existing
recipient definitions.



Suspending recipients

Click on the Suspend Recipient menu item. The following window will be displayed:

suspend Recipient - Date & Time

From 11-Apr-06 To 18-May-06
R Apiil 2006 o I May 2006 ]
2627 2 029 30 31 an 1 2 3 4 5 B
2 3 4 B B 7 8 oo o9 10 11 12 13
9 10 gy 12 13 14 18 14 15 16 17 18 19 20
16 17 18 19 20 A 22 2022 23 024 25 % O
23 24 2/ 2B 27 B/ 29 28 29 0 AN 1 2 3
w1 2 3 4 5 B 4 B B 7 &8 9 10
o Today: 11-Apr-06 T aToday: 11-Apr-06
~Time ~Time
Haur Minutes Hour Minutes
m - IEIEI 'I 23 = |99 =

LCancel |

A recipient may be suspended for any time period. Select the date interval using the calendar objects. Set
the "Time From" and "Time To" properties.

When a recipient is suspended you may see the suspension period in the recipients list (see above).

To cancel a recipient suspension, click on the "Resume Recipient” menu item.

Finding recipients

To find a recipient, click Ctrl+F keys, use the Recipients menu item or click on the Find Recipient button.
The following window will be displayed:

§_Find Recipient

B

Recipient

" Phone/SHS number INE‘EEEE

|Mike

Find |

LCancel

You may find a recipient by name or by phone number. To find another user with the same name, click on

the Find Next button.



HTML report

You may create an HTML report that shows the alarms that a recipient is included in.
You may use the checkboxes in the list-box to select recipients that will be included in the report. Click on the
"HTML report” button to create the report.

See below a sample report:

/3 D:\Program Files',Control-See',UCME-OPC-DDE 5.6 UCME alarms per user.html - Micr oft Inte 101 =l

J File Edit ‘iew Favorites  Tools  Help

J $mEack ~ = - (5 ot | ihsearch G Favorites lfMedia £ | By S5 - |JLinks 2

J Address @ C:\Program Files\Contral-Seet JCME-CPC-DDE 5-6".UCMEj ﬁ‘Gn |J Martam Internet Security @8~ |J MNorton Antivirus & -

e

U.C.ME - Alarms-Users report

Recipient

Phone/SM5/Fax/Email |Suspended until |Alarms
name

1. Main Labby temperature too high =
$302:Randorm. Intd=TAGVALUE

. [AlarmiD=2. al]

By CheRion =246 B8y : 2. Vale Y104 is open! [AlarmiD=3 i

3. Fire alarm - building G127 [AlarmiD=4. alr]

1. Main Labby temperature too high =

$302: Random. intd= TAGVALUE s
Mark BESMS  |B18643550755 - [AlarmiD=2. al]

1. Main Lobby temperature too high =

04-12-2006 00:00 2302:Random Intd=TAGVALLFE
Mike@EF ax 7496563 to 05-31-2005 [Aiarenl0=2 al]
02:00 2. Vahe V104 is opent [AlarmiD=3 aln

In this sample report you may see that the user called David.G@Phone is listed in three alarms as displayed
in the Alarms column.



Time and Day settings

The following window enables you to set the time intervals and the days in which U.C.ME is allowed to send
messages.

ES Properties [ x|
Mame FPhone Number/E mail Password  Paging system  Protocal

[Mark.B |a72507333488 Jrwi [sMs | |CeluarTEXT =l

[V WwiP-2 compatible cellular phone

Special day 1 00:00 2359 0000 00:00 00:00 o000
Special day 2 00:00 2359 00:00 00:00 0000 o000
Special day 3 00:00 2359 0000 00:00 0000 o000

rTime and Lray
Interval 1 Intereal 2 Interval 3
From Ta From To From Tao Fricrity
|nn:uu |uu:un |uu:nn |uu:un |nn:uu IDD:DD |u_
Diay | From | To | From | To | From | To | Fricrity |
tonday a0:oo 2359 0o0:00 00:00 0000 o000 1
= | Tuesday Qo0 2359 0000 0000 0%00  OQO0 1 [Ufiaros |
M wednesday  00:00 2359 0000 00:00 00:00 o000 1
Thursday Q000 2359 0000 00:00 00:00 o000 1 Copy day |
Rieset al | Friday 0000 2359 0000 0000 0000 0000 1
S aturday a0:oo 2359 0000 00:00 0000 a0:00 1 Easte day |
Sunday a0:oo 2359 0000 00:00 0000 o000 1
1
1
1

Authaorization - Incoming phone calls and SMS command

I Enabil= Dialin W Suspend/Fesume Lser Motification [~ Fun Program [* exe)
[v Change Tag Values v Acknowledge Alam [~ Restart Computer et |
W Fe I Retrigve Alarms log ¥ Suspend/Resume Alam Matification e |

I~ Delete all alarms from queus

Ok Lancel |

M Name

User name (15 characters). Depending on the Paging system (Phone, SMS, Fax, Email) the appropriate
string will be added to the user's name. For example: David@SMS, Jim@Email, John@Phone and
Mike@Fax. These extensions will later on assist you to differentiate between the different users.

M Phone/Fax number or email

Phone/Fax number to dial to or email address.

M Password - Password (1 to 6 numeric digits). Required for phone recipients only. For other users the
string "null" will be automatically used.

M Paging System — Use phone, fax, SMS or email.

M Protocol — Use one SMS protocol.

™ Priority - The “Priority” may be any value from 0 to 9. If desired, U.C.ME may sort the alarms’ dialing list
according to the priority defined for each name in the list. If priority is set to 0, the user won't get any
messages at that day.

You may use the three time intervals to define time intervals. All time intervals may be in the same day.

Set or reset on the “Day” check-box to enable/disable the dialing during that day.



In addition to the regular weekdays there are additional three special day types:

Special_day_1

Special_day_2

Special _day_3

These definitions will take effect when defining special days (i.e.: holiday). See "Special days" definition
below.

By using Priorities, you can change the order U.C.ME sends the alarms.
The priority may be different for each day of the week. In addition, if one user is on vacation, you may set his
priority 0. In this case U.C.ME will not dial to this user.

Authorizations

M Enable dial-in - Determines if a user is allowed to dial-in into U.C.ME

M Enable deletion of alarms log file - Determines if user is authorized to delete alarms (from history files)
while playing them via phone.

In addition, it lets you set different authorization levels for each user. For example, one user may be
authorized to perform actions via SMS while others are not.

WAP-2 compatible cellular phone

U.C.ME and its snapshot functionality enable recipients who carry cellular phones with WAP-2/XHTML
support, to receive alarms together with their snapshots. (See below). Set this parameter if you wish that the
recipient will receive alarm snapshots in XHTML format.

o Btart Alarm Feb-04-2005 11:53:14
s Adr-condition unit B] - Chiller C2
Retwning water - temperature ton low

Temperature main lobby 9 Celsias
Hot water pump On
Cold water pump CHT

Hot water temperature 18 Celsins
Cold water temperature 4 Celsms




Defining Recipient groups

It may be more convenient to define alarms with groups rather than having long list of recipients.
See below the first window that will be displayed. The existing groups will be displayed in the list-box. You
may delete; copy or paste groups.

Group deffinition x|

Awailable groups

Mew group...

SMS_EInI_I,I.gmup

Delete group

LCopy group

PBaste group

Exit

To create new group click on the "New group..." button. The following window will be displayed:

iif Group definition (security.group) 5'

i

Recipients

David. G.@Fhone

i

4 recipients in group

David. G.@Fhone

Mark BESMS Mark BESMs
Mike@Email @ Mi ail

Mike@F ax q 5 @
Mike@Phone i i

M\ke%BMS

Down

Save group | Cancel

In the above window there are two lists. On the left-hand side you can see all the users that are define in
your phonebook. In the right-hand side, you can see the users that are members of the group.

To add or remove users you may use one of the following ways:
1. Double click on the recipient name.
2. Select a recipient and click on the "Add one" or "Remove one" button.
3. Drag and drop the recipient from one list to the other.

To remove all recipients from the group, click on the "Remove all" button.
You can change the order of the recipients in the group by selecting a recipient and then moving it up or

down using the "Up" and "Down" buttons. When including a group in alarm'’s recipients list, the order of the
users will be kept.



To save a group, click on Save. The following dialog box will be displayed.

Enter Group file name x|

Enter group file name:

Mew

QK LCancel |

Enter the group name and click on OK.

When deleting a group, the following dialog-box will be displayed.

Delete group? x|
@ Deleting "Mew . group”, Are wau sure?
Yes Mo Cancel

If "Yes" is selected, the following dialog-box will be displayed.

@ Delete "Mew,group” Fram all alarms?
hi

Bs Mo Cancel |

If "Yes" is selected, the group will be deleted from all alarm and family-templates.



Shifts definition

In some cases, organizations choose to send alarm notifications according to predefined work shifts.
U.C.ME enables you to design weekly shifts — up to 3 shifts a day.

When using shifts in alarms, the recipient notification list is taken from the shift's definition and not from the
alarm itself. At run-time, U.C.ME will search for a shift instance that matches the current date and time. If
such shift instance is found, the recipient list will be taken from it.

In case where a shift instance is found and a special day (holiday) is defined at the same date, U.C.ME will
check each recipient for its special day settings to see if the alarm notification can be sent.

The first thing you should do is to create the shift model. You may correlate shift models to alarm families are
to any other subject. See the window below:

2% shifts definition

Shift Models Shift valid within dates

Model Mame Shift Name | Fram | Ta | Description
FIRE 2003/0910  2003/09/30 My first shift
AiCandition FIRE 2003/06/01  2003/07/31  June-July
New model Mew Instance
Delete model Delete Instance
s «I | o

i

Save | LCancel

Click on the "New model" button to create a new shift model. Once the model was created, you may start
creating new instances. One shift model may include unlimited number of instances. For example, you can
create 12 instances for the next 12 months: Jan, Feb...Dec.

Click on the "New instance" button to create a new instance. The following window will be displayed:

4% shifts definition x|
Wigt
Shift madel |EvidinaSupport Index |3 Fram: IZDUB-U4-U1 _I Ta |2UUB-U4'3U |Undefined recipients/groups
Description IWDrk Week Schedule
Fiecipients IPauI@SMS j Groups I j ‘l | ﬂ
Sunday Monday Tuesday wiednesday Thursday Friday Saturday
IV Shift 1 ¥ Shift 1 ¥ Shift 1 v Shift 1 [V Shift 1 IV Shift 1 ¥ Shift 1
Fram To Fram Ta Fraom Ta Fram Ta From To Fram Ta From Ta

|u?:nn |15:m3 |n?:m3 |15:m3 |a?:nn |15:m3 |n?:na |15:nn |u?:m3 |15:m3 |n?:aa |15:m3 IB?:BB |15:E1l]
Mike@5MS

D avid. G.(@Phone Mikef@5S

Paul@shs David,G.@Phane

Mark BERIMS

v Shift 2 ¥ Shift 2 [+ Shift 2 ¥ Shift 2 [v Shift 2 ¥ Shift 2 [+ Shift 2
From To From To From To From To From To From To From To
|15:nn |23:nn |15:m3 |23:nn |15:nn |23:[1l3 |15:nn |23:un |15:m] |23:nn |15:m3 |23:nn |15:nn |23:[1l]
Wil & GE mail M ark B@EMS Mike@EHMS Mark BEEMS Mike@EME Mark, g Mike@EMS
D avid.G. {2Phone [ avid. G.{8Phone David. G.@@Phane
Mike@EME Mark B@EMS
¥ Shift 3 ¥ Shift 3 [+ Shift 3 ¥ Shift 3 ¥ Shift 3 ¥ Shift 3 [+ Shift 3

From To Fram Ta From Ta From Ta From To Fram Ta From Ta

lan.an laz.aa lan.an | law.ana lan.an laz_aa lanas laz.as laniaa  laz.an laniae lav.ae  lanias lasiaa



You may drag and drop recipients to each of the shifts in each of the days.
To copy recipients from one shift to another, drag and drop a recipient while pressing on the shift key.

Each day may contain up to 3 shifts. To disable a shift click on "Shift 1", "Shift 2" or "Shift 3".

Specify the shift's Date range. The shift instance will be valid only when the current date is within the shift's
date range.

Note:
Make sure that you don't have two (or more) shift instances with overlapping date intervall
U.C.ME will find the first shift instance that matches the current date (when the alarm occurs).
Therefore, the users' list per alarm may be unpredictable.




Design Alarms

1 Design Alarms '

alarms  Tools

Alarm Filker |Enteryour test biere...

Ix

Blarm test I 18] I Server I Tag I
Ak Motor Mumber 1 has overheated 13 Factary-Server Devicel .l
A& Motor Mumber 1 has low oil 14 Factary-Server Devicel Groupl.1
A& Motor Mumber 2 has overheated 15 Factary-Server Devicel AMAT |
A& Motor Mumber 2 has low oil 16 Factary-Server Devicel Groupl .2 |
A& Motor Mumber 3 has overheated 17 Factary-Server Devicel Groupl .2 | Mew
A Motor Mumber 3 has low o 13 Factom-Server Devicel.Limit] |
F-% otor Mumber 4 has ov Simulation-Server rigade. Reald Copy
A Motor Mumber 4 low oil 20 Simulation-Server Bucket Brigade.Int2
A Motor Mumber 5 has overheated 21 Simulation-Server Bucket Brigade.Intd : Paste |
A Mator Mumber 5 has low il 22 Simulation-S erver Bucket Erigade.Int1 i —
Delete |
HTHML Fepart
| | 2

Daone | Find Fird Mest

| Total number of alams: 10

Creating alarms

To create a new alarm, Click on the "New" button, or click on "New Alarm™" menu item. You may also use
the "Ctrl+N" combination keys.

Copying alarms

To copy an existing alarm, select an alarm and then click on the "Copy" button. To create a new alarm
based on the copied alarm, click on the "Paste" button. You may also use the "Copy alarm" and "Paste
alarm" menu items or click on the "Ctrl+C" and "Ctrl+V" keys respectively.

Deleting alarms

To delete alarms, select the alarms you wish to delete and click on the "Delete selected alarms" menu item.
You may also use the "Del" key.

Defining multiple alarms

To define several alarms which have similar properties, select the alarms you wish to define, and use the
mouse right button to click on the "Define selected alarms..." menu item. Please note that some properties
are not available when defining multiple alarms. For example: alarm condition, voice file and more. These
properties are available only when defining single alarm.

You should switch between the different tabs to ensure that you are satisfied with the multiple alarm
properties.



The first step in the alarm definition is to define the alarm condition. The following window will be displayed.

[+ e denion x
Alarm text IMotor Murmber 1 has low oil
Group Alarm 1D [~ Use alarm family template
[ =l e [ =] I Shittinuse ™
[ T elephony T Fax T Alarm Snapzhat
Recipients T Voice files T Alarm condition
rCanditior
Server IFactor_l,l-Sewer j Tag |Device1.Group‘I.‘I |
Candition |= j Yalue |1
rilarm inhibit tag
Server I j Tag I —I
Alarm dizabled between: IUD:DD IDD: oo
Categaom IAIarm Cateqary [~ High severity alamn - always natify

[~ Matify when alarm ends

Sub-categary 1 |Sub Categony] Sub-categaon 1. |
I Retries count: |5
Suh-categow2|5ub Category2 Sub-categary 2. | T

Histony
[~ Log to histary

[~ Alam disabled

Save | Lancel

General Alarm properties

M Alarm text - Type the alarm text.
M Alarm ID - This property is automatically set by U.C.ME. It is used to have unique alarm identification.

M Group (Telephony only) - Each alarm may be associated with a group. For example, all fire alarms may
be associated with the “Fire” group. When the alarm is generated, U.C.ME adds a record to the daily alarms
log file. The file name format is: YYMMDD.WVL, where YY(00 to 99) is for the year, MM(01-12) is for the
month, and DD(01-31) is for the day of the month.

Each record in this alarms log file also contains the group number. This may be later used, when the user
calls U.C.ME (Incoming call) and asks for an alarm voice report for all alarms belonging to a specific group.

M Use Alarm Family template - In case the alarm is included in a family template, you may select the
appropriate template. In this case, few of the alarm's parameters will be taken from the template. These
parameters will be disabled in this window. The only properties that you can change in this case are: the
Voice file names and the alarm's actions.

In addition, the text "Alarm Template" (in Red) will be displayed in the Red color to indicate the family
correlation.



Alarm condition

M Server Name — Select an OPC or DDE server.

M Tag Name - type the tag name, or click on the Browse button in case you are connecting to an OPC
server. If you are connecting to a DDE server, you shall have to write the tag name.

When clicking on the Browse button, the following window will be opened:

x4
OPC Server: I{M?C43E0-433E-1 100-9F78-005097 244200}
Branches: Items:
E@ Al iterns MHame | Type | Acocess ﬂ
E‘@ Devicel 1B M an retries .
'@ Groupl @ Tagl
@ Tag?
@ Tag3
@ Tagd
@ Tagh
@ Taagk
JBrwian ENa.
JBrwiay STO. =
a | &
Itemn |D: IDevice'I Groupl.1
Select filter .. [~ Apply filter [~ Show types Properties .. |
(0] 4 | Apply Cancel | Help |

Double-click on one item. Its name will be automatically inserted to tag name field.
M Condition — select a condition from the list. For example "<=", ">=", "=" etc...

M Value —type the alarm condition's value.

M Retries count —type the number of retries that U.C.ME should use in case it fails to send the alarm.

M High severity alarm — always notify - To enforce alarm notification, use this property. If set, the alarm
will be delivered no matter what are the user's time and day settings.

M Notify when alarm ends - Set if you want that U.C.ME will dial when the alarm ends.

M Alarm disabled between - You can disable U.C.ME from dialing to the phone list in a specific time
interval. To disable the alarm set the time interval in which the alarm is disabled.



M Category
Please specify the alarm's category. For example: "Reactor", "Conveyor", etc... These categories will be

displayed together with the alarms and will help you perform alarm filtering.
To add, delete or choose a category, click on the "Category..." button. The following window will be

displayed:

1 Add alarm category x|

IHeactu:ur

Category name

Add

Delete

Done | LCancel |

M Sub-Category 1
Each Category may have sub categories. To add, delete or choose a sub-category, click on the "Sub
Category 1..." button.

M Sub-Category 2
Each Sub-Category 1 may have sub categories. To add, delete or choose a sub-category, click on the "Sub

Category 2..." button.

M Save alarm to history - Set to instruct U.C.ME to save the alarm to history.

M Alarm disabled - Set to disable the alarm

M Timeout — In some cases you may want to delay alarm generation. When the alarm timeout exceeded
and the alarm is still active, U.C.ME will generate the alarm. If the alarm is ended before its timeout expired,
U.C.ME will not generate the alarm. The alarm timeout is set in seconds.

M Alarm Inhibit Tag — alarms may be inhibited according to the value of the Inhibit Tag. When the value of
this tag is non zero, the alarm will be inhibited. This functionality enables users to inhibit alarms in on-line
without changing the alarm definitions.



Voice files

Cnmaennon x
Alarnn bext |Main Labby termperature too high = $$02:Random. ntd=TAGWALLE
Group Alarm D [~ Use alarm Farmily ternplate:
2 =l |z | =l I shitinuse | =
[ Telephaony T Fax T Alarmn Shapshat
Recipients T Yoice files T Alarm condition
Alarm Yoice files
Alam Voics file 1 (1equired) Main_Building &)
Alarm Yaice file 2 [optional] Fire_alarm | E
Alarm Voice file 3 [optional] ¢ ] 1 E
¥ Play alarm to local loud-speakers

If you are using telephony or multimedia, you need to select the voice file that will be played when the alarm
is triggered.

M Play alarm to local loudspeakers — set to play the alarm's voice file to the local loudspeakers when the
alarm is triggered.

You may select up to three voice file per alarm. U.C.ME will concatenate the voice files into one message.

For example, in the alarm displayed in the above window the following voices will be played:
"Main building fire alarm 3" floor."



Recipients

Alarm text |Main Lobby termperatuns too high = $502:R andom Intd=TAGWALLIE
Group Alarm 1D I Use alarm family template
f =l 2 | =] I shitinuse | =]
[ Telephony T Fan T Alarm Snapzhat
& T Woice files T Alarm condition
Recipients Groups
Mike@Email .
David.G.@Fhone Copy List |
ﬂ d Mark.BE@SMS :
Mike@F Faste List |
tike@Phaone :
&I Mike@Email Clear List |
Paul@sms
[elete | SMS delivery method
ﬂ m dd User | = Send SMS to all recipients

Browse Recipients... Browse Groups...

£ Stop SMS notification after successful delivery to server/modem
% Stop SMS notification after recipient acknowledge

Wit |2 minutes before nest notification

Select the recipients and groups that need to be notified. You may drag and drop a recipient or a group into

the recipients list. When a group is added, it will appear with a '$' sign prefix.
For example: "Security".

When a recipient is included in the recipients list while he was deleted from the phone book, the "Undefined
Recipients" list will turn yellow. Once this recipient is deleted or re-defined in the phone book, the color will

become white again. See below.

Undefined uzers/groupz
R obert@Phone

Jd | B

U.C.ME will notify to recipients in this list in the same order which they are displayed.

You may change the recipients order by using the Move Up and Move Down buttons:

U 4



SMS Delivery method

U.C.ME may send SMS messages in one of the following methods:
1. Send the SMS to all recipients included in the recipients list.
2. Stop sending the SMS after successful delivery to one of the recipients (successful delivery means
that U.C.ME received confirmation from the modem/server that the message was successfully sent).
3. Send the alarm to one recipient, wait XX minutes for acknowledge. If acknowledge was not received,
send the alarm to the next recipient etc... If acknowledge was received, stop the SMS notification.

SM5 delivery method
i~ Send SMS to all recipients

™~ Stop SMS notification after successful delivery to server/moderm

% Stop SMS notification after recipient acknowledge

W ait |5 rinutes before next natification




Telephony

x
Alarnn bext |Main Labby termperature too high = $$02:Random. ntd=TAGWALLE
Group Alarm D [~ Use alarm Farmily ternplate:
fan =l |z | =l I shitinuse | =
[ Recipients T Woice files T Alarm condition
Telephony T Fax T Ailarm Snapshot
réchion

[~ acknowledge

[ Recod voice reply

[¥ Tag action q;)> Tagéction I E
Action type ISel_interaclive_tag_value j
Server IMatrikon.UF‘C.SimuIation.'I j Tag IBucket Brigade.Int2 |

[~ sk for # ta verify "End OF Call"

Drial to: IAII 'l

M Acknowledge — set to enable alarm acknowledge over the phone.

M Record_voice_reply

Used for recording voice replies. Use this option if you want that the phone call receiver will record his replay
after he hears the alarm message. The recording is stored on the hard-disk and can be later heard by
authorized personnel.

The recorded file name will be in the following format "Family - User-Name Date - Time wav". The recorded
files will be stored in the "\Voice Files - Replies" folder.

M Tag action (one of the following)
Set_interactive_tag_value - For interactive tag value assignment
Set_interactive_tag_value(time) - For interactive time-tag value assignment
Play_message_and_tag_value - For playing the voice message and the tag’s value
Set_fixed_tag_value - For pre-defined tag value assignment.

For each tag action you should set the appropriate parameters.
For example, for the “Set_fixed_tag_value” action, you should set the tag name and value.

™ Ask for password

This is an optional parameter that instructs U.C.ME whether to ask for the password from the phone
receiver. If this field is not set, U.C.ME will play the alarm voice file immediately after the call has been
answered.



M Ask for # to verify “end of call”

This is an optional parameter that enables U.C.ME to verify if the call has ended with no problems. If this
parameter is set, U.C.ME will ask for the “#” key at the end of the call. If the person who receives the call will
click on the “#” key, U.C.ME will “understand” that the call has ended successfully. If not,

U.C.ME will re-dial and transfer the voice message again.

M Send to - Set the “All” or “One”. If “All” is defined, U.C.ME will dial to all of the phone users in the list. If
“One” is defined, U.C.ME will stop dialing after one phone user from the list answered the call and confirmed

its reception.

Selecting, recording and playing voice files

There are three voice file that you may define:
1. Alarm voice file.
2. "More Info." voice file.
3. "Tag action" voice file.

To select a pre-recorded voice file, click on the voice file button. The following window with the list of all voice
files will be displayed. Double click on the desired voice file, or select a voice file and click on the “OK”

button.
#% Select voice file...
File:

[~ Prefix Filker I [ Show systemn files

ame | Size Type | Last modified =
'-RE 3rd_floar.way 11082 Private 18-4pr-06 12:40:52 PM
'-JEAII.wav 13838 PFrivvate 12-Feb-06 12:51:20 Pt

12.Feb-0 D
\lﬁ Driall 00 waw 44154 PFrivvate 17-Apr-06 5:31:18 P
JE Diallm wav EIE Pivale  17Apr0B B3R57 PM | I |
%& Diall 02 waw 7174 Privvate 17-Apr-06 5:39:30 P -
'-'JE Diall 03.way BE202 Private 17-4pr-06 5:40:37 PM @E
\lﬁ D?al‘l 04, wav BR17E Pr?vate 17-Apr-06 5:41:40 P Play \;AV
\lﬁ Diall 05.way 24862 Private 17-4pr-06 5:42:21 PM —_—
%& Diall 06, waw 24862 PFrivvate 17-Apr-06 5:42:37 P =
'-'J_E Diall 07 wayv 38642 Private 17-4pr-06 5:43:03 PM 2
%& Driall 08, waw 30374 PFrivvate 17-Apr-06 B:02:08 P Recard Wi,
JE Diall 09, wav 24862 Private 17-4pr-06 £:02:54 PM e
%& Diall10.way 27E18 Privvate 17-Apr-06 B:03:10 P
%& Diall 11 waw 35886 Privvate 17-Apr-06 B:10:26 P
%& Diall12. wav R2422 Private 17-Apr-06 B:11:02 P
%& Diall13.wav 22106 Private 12-Feb-06 1:55:30 P
SEDial14.wav 24862 Private 03-Apr-06 5:14:52 PM LI
oK

Lancel |

The "Play WAV" and "Record WAV..." buttons will be displayed only if the voice file format is defined as

WAV.

n hello - Sound Recnrdef

File Edit Effects Help
Position: Length:
200 zec. 278 zec.
|
I

| w | > |

=10l x|

U.C.ME launches the Windows™ Sound Recorder program. By using a microphone connected to your

sound card, you can easily record new voice files.

You may record new voice files or re-record existing files.




Note: Make sure not to change the file "empty.wav". This file is used as a template for every
recording.

To play a WAV voice file, select the file and click on the "Play WAV" button.

Note: If a voice file does not exist, its name on the button will be marked with a special strikeout
font. For example: FIREOOt-wav-

Fax
x
Alarm text IW’ater injection - valve is open
Group Alam 1D [~ Use alarm Family template
Ja = | =l
I Shittinuse | =
( Users T Woice file Alarm condition
Telephany T Fax Alarm Snapshot

v Attach More Info! Id:\F‘rogram Files“Contral-See UCME -OPC-DDE 4. _l

v Attach Alarm statistics

When sending alarms to Fax recipients, you may attach additional text file to the fax. In addition, you may
attach alarm statistics.

Click on the Browse button to select the attached text file.




Alarm Snapshot

1 Alarm definition ; ﬂ
Alarm text ITemperature too high Bioler 110 [ $$02.Bucket Brigade. Int2=TAGWALUE |
Group Alarm 1D [~ Use alarm family template
Ja ] | =] I shitinuse | L
[ Recipients T Yoice files T Alarm condition
Telephany T Fax T Alarm Snapshot
¥ Check Tag range
Min ¥ alue b ax Value
£ Nurm,  Mum,
Description Server JTag Units Tag Type &+ Tag _! I[P'CS]--‘M'F_2£ &+ Tag _I I[PCS].AIT_Qi
|matrikon1 Watrikon.OPC. Simulation. 1 j |[PES]_AIT_; |aaa IAnangj IMatrikon.DPE.Simulatiorj IMatrikon.DPE.SimuIaliorj
- k # g
\/ FactompSaft] FactomnySoft. S ample. 1 Devicel.t.. bbb Analog Tag FactomS... Devicel... Tag Facto
\/ matrikon2 Matrikon OFC. Simulation. 1 [PCS1AIT...  aaa Analog Tag Matrikon...  [PCS5]Al. Tag b atrik:
j \(” FactomSaoft2 FactomSoft. Sample. 1 Devicel.t.. bbb Analog Tag FactomS... Devicel... Tag Facto
\/ ratrikion3 Matrikon. OPC. Simulation. 1 [PCS]1AIT...  aaa Analog Tag Matrikon...  [PCSLAL.  Tag I atrik
j \/ FactomSaft3 FactomSoft S ample. 1 Devicel G... bbb Analog Tag FactomS... Devicel.. Tag Facto
4| | 2l
f T ag representation in DBE———
[~ Attach image to 'Web snapshat I J e 4dd | Change Delete
[~ Attach image to Cellular snapshat I J ¢ DescriptionsVaus+Unite

[ attach dlam Snapshat ba email

Save [ LCancel

The alarm snapshot is optional. In case you don't need the alarm snapshot functionality, you may ignore this
tab. At the moment of the alarm, U.C.ME may capture up to 20 tag values that are related to the alarm. For
each tag in the snapshot you need to define the following properties:

M Description — the tag's description. For example: "Temperature set-point value".

M Tag name - the tag's name.

M Units — The units may be any string when the Tag-type is "Analog". For example: "Celsius".

When the Tag-type is "Digital" or "Bit", the Units field should be in the following format: "Text1*Text2"
where "Text1" is the text that will be displayed when the tag value is 0 and "Text2" is the text that will be
displayed when the tag value is 1.

M Tag-type — may be "Analog", "Digital" or "Bit_ NN" (where NN is the bit number between 0 to 31).

M Check Tag-Range — when set, U.C.ME will check the tag value against its required range. Each tag that
is out of its desired range will be marked as a possible alarm cause.

The "Min. Value" and the "Max. Value" properties purpose is to check if the tag value is within the desired
range. Use these properties to set the tag's desired range.

M Min. type — May be "Numeric" or "Tag". If "Tag" is chosen, the tag's "Min Value" will be taken from that
tag. If "Numeric" is chosen, you shall have to specify the numeric value.



M Max. type — May be "Numeric" or "Tag". If "Tag" is chosen, the tag's "Max Value" will be taken from that
tag. If "Numeric" is chosen, you shall have to specify the numeric value.

M Attach image to web snapshot — to attach an image that will be displayed together with the alarm
snapshot using the web, set this parameter and choose a file name (JPEG or GIF).

M Attach image to cellular shapshot - to attach an image that will be displayed together with the alarm
snapshot using a cellular phone, set this parameter and choose a file name (GIF, MP4 or 3GP).

M Attach alarm snhapshot to email — set to attach the alarm snapshot to email recipients.

Finding alarms
To find an alarm, click on Find. You may search for alarm text or alarm family name. Once an alarm was
found, you may click on Find next to find the next alarm that matches the searched text.

You may also use the Alarm Filter field to search all alarms that meets the filter.

I
| * Design Alarms

alarms  Tools

Alarm Filker |*temperature*

Alarm text

F-% T ernperature too high Bialer 2110 [ $302:Buck

A& Main Lobby temperature too high = $$02:Random. Intd=Ta... 2 b atrikon. OPC.£
For example:

*text1* - look for alarm text that contains the word "text1"
text2 — look for alarms text that starts with the text "text2"

To clear the alarm filter, select and delete the text inside the alarm filter box.

Disabling and enabling alarms
To disable or to enable an alarm, double-click on it and set the field "Alarm disabled" accordingly.

You can use the "Alarm disabled" column in the alarms window to check if the alarm is disabled or enabled.



Alarm validation

Use the Tools » Validate alarms menu to validate your alarms. This feature may save time trying to find
errors in your definitions.

The following dialog box will be displayed:
x|

Mizzing Yoice files:

Alarm 1D | Mizzing voice file |
1 test]
2 fire001

Tatal alarms in list &

The list-box will contain the list of voice files that you have defined in your alarms, but do not exist on your
hard-disk. The Alarm ID field will guide you the appropriate alarm that you need to fix.

In the lower part of the window you will see the following information:
e Total number of alarms

This information may help you to verify that alarms are well defined.

Forcing alarms

You may force alarm by selecting an alarm and then clicking on Ctrl+F. You may also use the mouse right
button and then click in the Force Start Alarm menu item.

You may force an alarm to:

1. Simulate the alarm (without having to change the alarm's tag value) to see how the notification
process works.

2. Create a predefined alarm scenario that is generated manually. In this case you may use dummy
alarm condition that will never be met. For example: in emergency situations where the source is not
a tag value, but an event that is created manually by the plant personnel.

U.C.ME Runtime module must be running to force alarms.



Alarm export and import to/from Excel

U.C.ME supports export and import functionality to/from Excel CSV format. In the Design Alarms window,
click on "Tools» Export alarms...". Set a file name and click on the "OK" button.

A CSV file will be created. See below sample file.

Arial -0 - B 7 U S=S=EBBw-F %, @8 Elui-B-A-

DEEHa8 GRY| BRI v &= -4 @ -0, 4.

B3 - fie Wiater injection - valve is open

= fH [ & [ F [ E | D [ ¢ | B | A
B 500 FVERSION |1
Alarm_shif Alarm_farm Alarm_val_Alarm_con Alarm_tag Alarm_id  Alarm text FOESCRIPTION 2
1= Devicel. Group1. 11 ater injection - valve is opey$ALARNM | 3
Micha@SMS $USER | 4
Micha@Email $USER | 5
M ew $USER | B
Murneric 0 Mumeric | Digital Opened*Closed Devicel. G Walve is FSNAPSHOT | 7
Tag Devicel LiTag Analog Meters Devicel. G Water level is FSNAPSHOT &
I~ Mumeric 1 Mumeric  |Bit_1 On*0ff Devicel AlBit 1 is FSNAFSHOT | 9
Mumeric 1 Mumeric  |Bit_2 Cn*0Off Devicel AlBit 2 is FSMNAFPSHOT 1o
D:\Docurn 1 PWEB_ATTACHMEN 11
D:\Prograr 1 $CEL_ATTACHMENT 12
1= Devicel. Groupl. 2 Reactor C12 - ternperature to SALARM 113
Murneric 80 |Murneric Analog  Celsius Devicel. AlReactor temperature FSMAPSHOT 14
Murneric 1|Murneric  Digital Opened*Closed Devicel. G Output valve FSMAPSHOT 15
Murneric 0/ Mumeric | Digital Started*Stopped Device1. & Transfer purnp FSNAPSHOT 16
MNumeric 1 Mumeric  |Digital Opened™Closed Devicel.5 Heating vale FSNAFSHOT 17
|~ Mumeric 1IMumeric  LAnalog . Device1.5 Batch number in process FIMAPSHOT 118

Open the file using MS Excel.

CSV File format

Line 1: $VERSION — U.C.ME version number.
Line 2: $DESCRIPTION — a description line that described each column
Line 3: $ALARM — the 1* line of the alarm
Column 2 — Alarm text.
Column 3 — Automatically set. Ignore this field.
Column 4 — Server logical name.
Column 5 — Tag name.
Column 6 — Alarm condition. Use <,>,=,<=, >=, Bit_NN (where NN is between 0 to 31)
Column 7 — Alarm value/ Must be numeric. Use 0 or 1 for digital tags or for Bit_NN condition.
Column 8 — Alarm family name. [Optional]
Column 9 — Alarm shift name. [Optional]
Column 10 — Alarm voice file name 1. Should not be an empty string.
Column 11 — Alarm voice file name 2. (Optional — may be empty)
Column 12 — Alarm voice file name 3. (Optional — may be empty)
Column 13 — Save to history. Use 0 for "No" and 1 for "Yes".
Column 14 — Alarm disabled. Use 0 for "No" and 1 for "Yes".
Column 15 — Dial To. Used for Telephony. Use "One" or "All".
Column 16 — Disable alarm "from time" HH (use 0 to 23) — hours.
Column 17 — Disable alarm "from time" MM (use 0 to 59) — minutes.



Column 18 — Disable alarm "to time" HH (use 0 to 23) — hours.

Column 19 — Disable alarm "to time" MM (use 0 to 59) — minutes.

Column 20 — Number of retries. Must be >= 1.

Column 21 — Handle end-alarm. Use 0 for "No" and 1 for "Yes".

Column 22 — Always notify. Use 0 for "No" and 1 for "Yes". If set to "1", U.C.ME will ignore the
recipients time schedule and the alarm will be sent in any case.

Column 23 — Alarm acknowledge. Use 0 for "No" and 1 for "Yes". If set to "1", alarm acknowledge is
enabled via phone or SMS.

Column 24 — Acknowledge file name. Must be "ack".

Column 25 — Record voice reply (telephony only). Use 0 for "No" and 1 for "Yes".

Column 26 — Record voice reply file name (telephony only). Must be "dummy".

Column 27 — Tag action (telephony only). Use 0 for "No" and 1 for "Yes".

Column 28 — Tag action voice file name(telephony only). If column Z is 1, a valid file name must be
used.

Column 29 — Tag action type (telephony only). Use valid tag actions. For example:
"Set_fixed_tag_value".

Column 30 — Tag action tag name (telephony only). Use valid tag name.

Column 31 — Tag action server logical name (telephony only). Use valid OPC or DDE server name.
Column 32 — Tag action tag value (telephony only). Use valid tag value.

Column 33 — Ask password (telephony only). Use 0 for "No" and 1 for "Yes".

Column 34 — End of call verification (telephony only). Use 0 for "No" and 1 for "Yes".

Column 35 — Alarm group (telephony only). Should not be empty.

Column 36 — Play alarm to loudspeakers. Use 0 for "No" and 1 for "Yes".

Column 37 — Shift in use. Use 0 for "No" and 1 for "Yes".

Column 38 — Shift name. If column Al is 1, column AJ must contain a valid shift name.

Column 39 — attach snapshot to email. Use 0 for "No" and 1 for "Yes".

Column 40 — Fax attachment. Use 0 for "No" and 1 for "Yes".

Column 41 — Fax attachment file name (*.txt). If column AL is 1, column AM must contain a valid file
name.

Column 42 — Fax statistics attachment. Use 0 for "No" and 1 for "Yes".

Column 43 — Alarm category. Use a valid category name.

Column 44 — Alarm Sub category 1. Use a valid sub category name.

Column 45 — Alarm Sub category 2. Use a valid sub category name.

Column 46 — Snapshot format. Use "DESCRIPTION" or "VALUE". When "DESCRIPTION" is used,
U.C.ME will use the snapshot's full description. i.e.: "The temperature is 25 degrees". When
"VALUE" is used, U.C.ME will use the snapshots value only. i.e.: "25".

Column 47 — Timeout (in seconds).

Column 48 — Inhibit tag name.

Column 49 — Inhibit OPC or DDE server logical name.

Column 50 — SMS delivery method. Use USER_ACK, SERVER_ACK or SEND_ALL.

Column 51 — SMS wait time (in minutes). If USER_ACK was defined as the delivery method,
specify the number of minutes to wait before sending the SMS to the next recipient.

Line 4: $USER — contains 1% user name. For example: Mike@SMS. [Optional line]
Line 5: $USER — contains 2™ user name. [Optional line]

Line N: $SNAPSHOT - line per tag contained in the snapshot [Optional line]



Column 2 — Tag description

Column 3 — Tag name

Column 4 — OPC or DDE server logical name

Column 5 — Tag units

Column 6 — Tag type (Analog, Digital, BIT_NN)

Column 7 — Min. value type (Numeric or Tag)

Column 8 — Min. value. If column 6 is "Numeric", column 7 must be numeric. If column 6 is "Tag",
column 7 must be a valid tag name.

Column 9 — Min value - OPC or DDE server logical name

Column 10 — Max value type (Numeric or Tag)

Column 11 — Max value. If column 8 is "Numeric", column 9 must be numeric. If column 8 is "Tag",
column 9 must be a valid tag name.

Column 12 — Max value - OPC or DDE server logical name

Column 13 — Check tag range. Use "1" to enable U.C.ME to check the tag's value against its
required range. Use "0" to disable.

Line N+1: $SNAPSHOT - line per tag contained in the snapshot [Optional line]

Line P: SWEB_ATTACHMENT - contains web snapshots graphics attachment info. Use "1" in column B if
you want to attach a graphic image (*.gif ; *.jpg) to the web alarm snapshot. Type the file name in column C.
Use "0" in column B for no snapshot attachment.

Line P+1: $CEL_ATTACHMENT - contains cellular snapshot graphics attachment info. Use "1" in column B
if you want to attach a graphic image (*.gif ; *.mp4) to the cellular alarm snapshot. Type the file name in
column C. Use "0" in column B for no snapshot attachment.

To import the Excel CSV file to U.C.ME, click on "Tools » Import alarms..." menu item. The following
message will be displayed.

Alarm Impork X|

@ Maote! Importing alarms will cause new alarm indexing, Conkinue?

Yes Mo | Cancel |

Note: When importing alarms, alarm IDs may change. As a result the alarm database file may contain
occurrences of the same alarm but with different ID.

Click on the "Yes" button, to continue the import process. The import process might take some time
depending on the file length.
A progress bar will be displayed at the bottom of the window to indicate the progress of the import process.

Note: you should close Excel before starting the import operation.




Importing alarms from SCADA/HMI applications

Note:

Before importing alarms from other applications, you must check the following:
1. MS Excel is installed on your computer.
2. MS Excel is closed before starting the import.

To import alarms, open the Design Alarms window. Use the Tools menu to import alarms.

1. Design Alarms
| Toals

Delete all alarms. .. I
Export alarms. .. | D | Tag
Irnpart Cimnpliciky alarms. .. . 42 POINTS
Yalidate alarms. .. Import Cikect alarms. .. Lo 43 PROCESS_CORHMS
ik Corn Syrup Tank  Import InTouch alarms, .. 44 PROCESS_CORNS
A& Flavor A Tank -- Import RS-Yiew alarms. .. 45 PROCESS_FLAYOI
Ak Flavor A Tank -- Impart UL, C.ME alarms, . Lo 46 PROCESS_FLAYOI
A& Flavor B Tank -- State: --Level: o 47 PROCESS_FLAYOI

A& Flavor B Tank -- State: ZSTATE--Level: VAL LoLo 48 PROCESS_FLAYOI
& Prareee Temnerahirs in alarm ctate ¥STATF- W 449 PRNOIMFSS TFMWPF




Importing alarms from CiTect®

U.C.ME enables users to import alarms defined in CiTect. Use the Tools » Import CiTect alarms menu
item (inside the Design alarms window) to import CiTect alarms. The following window will be opened:

Choose Citect DEF alarm file... i 2=l
Lok ik Ia Erample j = = ER-

] anasim, DEF:
digalm, DEF

File name: I j Open I
Files of type: I,L\Iarm files (= dbf) j Cancel |

4

[ Open as read-anly

U.C.ME support CiTect analog and digital alarm files. The file names that can be selected are:
= anaalm.DBF - for analog alarms
= digalam.DBF — for digital alarms

Importing CiTect® Digital alarms

U.C.ME scans the digalam.DBF file and will use the following columns:
Column 4: VAR_A — will be used for alarm's Tag Name.

Column 6: CATEGORY - will be used for alarm's Category.

Column 10: COMMENT — will be used for the alarm's Text.

10 [ 9 | 8 [ 7 | 3 [ 5 [ 4 | 3 | 2 [ 1
CE COMMENT HELF FRIY AREA CATEGORY WAR_B WAR_A DESC  NAME TAIG L1
Motor Mumber 1 has overheated BIT_1 @ Motor 1 Overheated) ALARM 1 | 2
Motor Mumber 1 has low ail BIT_2 E&@(Motor 1 Low Qil) ALARM_2 | 2
Matar Number 2 has overheated BIT_3 @ (Mator 2 Overheated) ALARM 3 | 4
Mator Mumber 2 has low oil BIT_4 @ (Motor 2 Low Oil) ALARM_4 e
Motor Mumber 3 has overheated BIT_5 @ (Motor 3 Overheated) ALARM_S | E
Motor Mumber 3 has low ail BIT_& E&@(Motor 3 Low Qil) ALARM_B |7
Matar Mumber 4 has overheated BIT_7 @(Motor 4 Overheated) ALARM_7 | €
Mator Number 4 low oil BIT_& i@ (Motor 4 Low Oil) ALARM_S | 5
Motor Mumber 5 has overheated BIT_9 @ (Motor 5 Overheated) ALARM_9 i
Matar Mumber 5 has low oil BIT_10 @(Motor 5 Low Oil) ALARM 10 [ 1
17
Note:

Lines with empty COMMENT or VAR_A fields will be ignored.




Importing CiTect® Analog alarms

U.C.ME scans the anaalm.DBF file and will use the following columns:
Column 3: VAR — will be used for alarm's Tag Name.

Column 4: HIGH — will be used for alarm's HIGH alarm.

Column 5: HIGHHIGH — will be used for alarm's HIGHHIGH alarm.
Column 6: LOW — will be used for alarm's LOW alarm.

Column 7: LOWLOW — will be used for alarm's LOWLOW alarm.
Column 13: CATEGORY — will be used for alarm's Category.

Column 17: COMMENT — will be used for the alarm's Text.

mousn ~ 1

| 17 [ 15[ 14a] 13 [ 2] = [ wm | 8] &8 [ 7 [ &] 5 | 4| 3] 2

ECOMMENT PRIV AREA HELP CATEGORY FORMA DEVIATION SETPOINTRATE DEADBAND/LOWLOWY LOW HIGHHIGH HIGH vAR  MAME
Setpoint Alarm #aEI o000 000001.0000  Y.0000  10.000095.0000 “85.0000LOOF @(Set
Bed_Depth Alarm ##EODOO0 00000 1.0000 00000 10.000195.0000 “185.000L00F :@(Bec
Temperature #AFEL ) Y25 Tos 78 Tempen@(Ten
Note:

Lines with empty HIGH, HIGHHIGH, LOW and LOWLOW fields will be ignored.




Importing alarms from InTouch®

U.C.ME enables users to import alarms defined in InTouch. Use the Tools »Import InTouch alarms menu
item (inside the Design alarms window) to import InTouch alarms. The following window will be opened:

Choose InTouch DB.CSY alarm file... ) e d |
Loak ir: I 5 demoappl_1024 j = £ Ef-

[
w8

ty Documents

File narne: IDB j Open I
Filez af type: I,-'l'-.larm filez [*.cav] j Cancel |

4

[ Open as read-only

U.C.ME searches for the file DB.CSV. This file may be created using the DBdump utility (usually located in
the C:\Program Files\Wonderware\InTouch folder) provided by Wonderware.

U.C.ME supports the following InTouch alarm tag types:
= Memory Discrete
= 1/O Discrete
= Memory Integer
= |/O Integer
=  Memory Real
= /O Real



Importing alarms from RS-View-32®

U.C.ME enables users to import alarms defined in RS-View. Use the Tools »Import RS-View alarms

menu item (inside the Design alarms window) to import your RS-View alarms. The following window will be
opened:

9 RS-Yiew Import B
& Tag C5V file name: | | I
Impart |
Alarm CSY file name: | |

Alarm tag

%]

| Alarm bext Cond. | Caond. vall Tag type I

Save | Lancel |

Use the Browse buttons —l to search for the Tag and Alarm CSV files. The following window will
appear.

Choose RS-Yiew Tag CSY file... ) 2

Look in: |3 ASVIEW-32 x| = ®EerE-
% IRSYS2-Alarms:

test_1-Alarms
.] kesk_1-Tags

File name: I j Open I
Files of type: ITag filess [*.c:av) j Cancel |
[ Open as read-only
4

After selecting the tag and alarm files, click on Import.



The RS-View alarms will be displayed in the list.

(RS viewImport E]

& Tag C5V file name: |D:\D ocumentzhS CADA C5V Files\RS-VIEW-324est_1-Tags C5Y _I

Alarm CSY file name: |D:\D ocumentzhS CADA C5W Files\RS-VIEW-324est_1-Alams. C5Y _I
14 valid alarms found.
Alarm tag | Alarm test I Caond. I Cond. «al I Tag bype
Fld144n Dev 1 Tag Description 1 LoLo < 10 A
Fid1'an Dev 1 Tag Description 1 La & 20 A
Fid14an _Dewv 1 Tag Degeription 1 Hi ¥ A0 A
Fld1%an Dewv 1 Tag Dezcription 1 HiHi b 100 I
Fld144n_tdem_1 Tag Description 2 LoLo < 10 A
Fld1%An_tem_1 Tag Description 2 Lo < 20 A
Fld1an_tdem_1 Tag Degcription 2 Hi ¥ A0 A
Fld1%&n_kdem 1 Tag Dezcription 2 HiHi » a0 A
FId1\Di_Dev_1 Tag Description 3 = 1 [}
FId14Di_Mem_1 Tag Description 4 = 1 D
FId1.Di_Mem_2_Cust_teg Tag Degcription 5 = 1 )
Fld1%Di_Mem_2_Sus_Msg Tag Dezcription & = 1 n}
FId1sDi_Mem 2 User_Msg Tag Description 7 = 1 [}
O FIdDi_Dew_1 S = 1 D

Save | Lancel |

Select the alarms you intend to export to U.C.ME. Unselect the alarms you do not intend to export to
U.C.ME. Click on Save.



Importing alarms from Cimplicity®

U.C.ME enables users to import alarms defined in Cimplicity. Use the Tools »Import Cimplicity alarms
menu item (inside the Design alarms window) to import your Cimplicity alarms. The following window will be

opened:

2%

Choose Cimplicity CS¥ file...

Look i Ia Cirnplicity j = i R

[

"-'1_'..' Documents

File name: [POINTS_Micha | Open |
Files of tpe: I,-’.'.,Iarm files [%.cav] j Cancel |

[~ Open as read-only

v

Select the CSV file name. The alarms will be imported to U.C.ME.

Note:
To create the Cimplicity CSV file, use the Cimplicity export utility as follows:

Clie export filename.csv




Alarm Families

To ease the process of alarms definition you can define alarm families. In case large number of alarms has
similar settings, an alarm family template can be used.

1 Design Alarm Families il

Family:

—

Farmily Status

[Empty]
FIRE [Empty] Add Famiy

Delete Family

i

Save | LCancel

To create a new alarm template, type the family template name and click on the "Add Family" button.
Double click on one of the items. The following window will be displayed.

1 Define Family Properties 1 ll

F arnily IY'Y'Y

réilarmn Family Propertie

I Shittinuse | B
[ Phone T General I_T Multimedia

Fau T Recipients
Recipients Groups
Mark B@Sms Copw List |
Mark B@Sms
Mark. BE@Sms Paste List |
FPaul@@msms
David.G.@Fhone Clear List |
Delete |
Add uzer |
ﬂ ﬁﬁﬁ SMS delivery method

Browse Recipients... Browse Groups... " Send SMS to all iecipients

{7 Stop SMS notification after successtul deliveny bo server/moden
{* Stop SMS notification after recipient acknowledge

Wit |2 minutes before next notification

LCancel

Save |

As you can see, this window is very similar to the alarm definition window. See the "Design Alarms" chapter
for explanations on the various options and settings in this window.




Alarm group names

U.C.ME enables the definition of ten alarm groups. Each alarm may be associated with a group name. This
name may be later used when you dial-in into U.C.ME and you ask for a voice report for a specific group (for
example: all Air-condition alarms or all Electricity alarms).

Group 0 is the group which includes all of the other defined groups.

Groups 1 to 9 are user defined. Please note that if you intend to dial-in and get alarm history reports, you
must record voice files for each group name. (for example: if you define a group named “Air-cond”, you must
record a voice file named “Air-cond” (wav or vox).

To record an appropriate voice file use the microphone button. To play an existing voice file, use the
loudspeaker button.

1 Alarm groups

|x

Allgroups — Jal E
Group 1 |FIRE E
Group2  [aRCOND 3] &)
Group3  [BURGLERY B &)
Group 4 [waTER E
Graup5 | =) E
Group 6 | ) E
Group 7 | E
Group | E
Group 9 | i E

Save | LCancel |




Alarm reports

U.C.ME enables you to receive alarm reports via fax or email. The report may be for a specific alarm, a
family of alarms or all alarms. The report may be a daily, weekly or monthly report.

1841 Alarm reports R |
Report name: IMnnlhI_l,J‘I
Fepart type
£ Alarm Farnily I j
Al alarms
Usgers Groups
[Daniel@Email [ | |
: : Sendon—————————— :
Daniel@Email Repart Time Interval:
IV Sunday  Time: IDD:DD
¥ tdonday IThis_Month "I
¥ Tuesday
v Wwednesdayp
v Thursdap
¥ Friday
Celete Lzer | Add Llzer | Add Group | ¥ Saturday
Feport name | Report timel Report type | In] | Time interval | Day of wesk |
a0.00 Allalarms All_al..  This_Month 111111 Add
0000 Allalarmz Allal..  “esterday 1110000 ¥
Delete |
Change |
Dione |

Report Type:
M Alarm Family — the report is for a family of alarms
M All alarms — the reports is for all alarms

Report Time Interval:

M Today - all alarms generated today

M Yesterday - all alarms generated yesterday

M This_Week - all alarms generated this week (Sunday this week to Saturday)

M Last_Week - all alarms generated last week (Sunday to Saturday)

M This_Month - all alarms generated this month (1* of this month until today)

M Last_Month - all alarms generated last month (1* of last month to the last day of last month)

Send on:
Set the day of the week and the time you wish the report to be created and sent.

Click on the "Add" button to add a new report.



Incoming phone calls

Incoming call enables users to perform actions disregard to alarm situations. This feature enables users to
dial-in to U.C.ME and to perform actions such as:

M Change tag values

M Retrieve active alarms’ list

M Retrieve historic alarms’ list

M Acknowledge alarms

M Listen to tag’s current value

M And more...

One may dial-in to U.C.ME, enter his password, and type an “Action Id”. If the password is correct, U.C.ME
will play a voice file describing the chosen action. Following this voice message, the user may press on the
“1” key and U.C.ME will continue and execute the action. Following this action, the user will be informed if
the operation succeeded or failed.

The Incoming phone calls window:

& Incomming phone calls x|
1D Action type
i | [T |Bet_ﬂ}{ed_tag_ualue j
Tag

Server IFau:tu:urySu:uft.Sample.'l j TagIDE'-.fiI:ETP-.NM | W alue |1 oo

Parameter] FParameter2
101 Get_alams_log 0
102 Set_interactive_tag_value 0:Devicel.Delete al... 0 dd
103 Set_interactive_tag_valueltime]  01:Devicel.l 0 =
104 Get_tag_walue M:Devicel.Dizable ... 0
105 Suspend_dial-out 0 Lhange |
106  Reszume_dial-out 1]
107 Delete_all_alarms_from_gueue -~ 1] |
108 Play_Last_10_alarms 1]
109 Action_Proagram 1004101+10247103+.. 0O L
110 Restart_Computer 1] Q
111 Run_Program CAWAMMT Seystemnd... 0O
112 Fiwm Praaram % Pranram File<h T A n
1
Save | E@: /2 Cancel |
Play Wwidhs Record 'wiah .
Fields
M ID 3 digits for action ID.

M Action See the following table for the supported actions.



M Parameter 1 - parameters required for the action.
M Parameter 2- parameters required for the action.
M Parameter 3- parameters required for the action.
M Voice File Status when an action's voice file does not exist, a proper message will be displayed.

Voice files naming convention for incoming phone calls
For each action you must record a voice file which will describe it. The file name format is: DIALhnn.WAV
(or DIALnnn.VOX) where nnn is the action ID.

Action Types

M Set fixed_tag_value - This action enables the user to assign a value defined in the “Tag Value” field
to the tag defined in the “Tag Name” field.

M Get_alarms_log - This action enables you to get a list of all historic alarms that were handled by
U.C.ME. This option is most important for applications without operators. Managers or technicians may call
U.C.ME and listen to a voice log of all alarms together with their date and time stamp.

The alarms are being played in a reversed mode. (i.e.: the most recent alarm is being played first)

For example:

“February 8, 11:25 - Main engine is not working.”

“February 8, 10:58 - Main lobby - temperature to high”

Press 0 to exit.

Press 1 to proceed to the previous historic alarm.

Press 9 to delete the current alarm.

Press * to repeat the current alarm.

The caller may delete an alarm by pressing 9, skip to previous alarm without delete by pressing 1, exit by
pressing 0, or repeat current alarm by pressing *.

If there are no alarms, U.C.ME will play the message: “No alarms”.

M Get active_alarms - This action enables you to get a list of all active (un-acknowledged) alarms. After
you dial in and choose the appropriate action id, you will get all active alarms together with their respective
time and date stamps.

Click 1 to proceed to the next active alarm.

Click 0 to exit.

Click 9 to acknowledge the alarm.

Click * to re-play the current alarm.

M Play_Last 10_alarms - This action enables you to get a voice list of the last ten occurrences of a
specific alarm. When you will choose this action, you will be asked to enter the alarm ID. U.C.ME will search
for this alarm in the last 60 daily alarms log files and will play the alarms in a reverse historic order, starting
from today and backwards.

M Set_interactive_tag_value - This action enables you to assign a new value to a tag. The new value is
entered interactively by pressing on the phone’s digits. This action enables the user to change tag values (for
example: set points, timers etc.) by using their phone at home or on the road.

After the user enters the tag’s new value, U.C.ME will play the following message: “The chosen value is
NNNNN, press 1 to confirm or any other key to continue.”

If the user presses the “1” key, U.C.ME will perform the action. If U.C.ME fails to set the new tag value, it will
play the message “Operation failed”. Otherwise it will play the voice file “Operation succeeded”.



For float values, you should use the “*” key as the “.” decimal point.
For example: the value 35.5 will be typed as: 35*5.

M Set _interactive_tag_value(time) - this action is very similar to Set interactive_tag value, except that the
value in this action is time value.

The time is value is entered in the Hours + Minutes format. For example: to assign the time value 20:47, you
should type “2047”.

If the time value is valid, U.C.ME will play the voice message:

“The chosen time is HH and MM minutes. Please press 1 to confirm, or any other key to cancel.”

If the “1” is pressed, U.C.ME will transform the time entered by the user to the time format defined in the
Settings window. The time format may be “Minutes_since_00:00” or “Seconds_since_00:00". For example
the time value 06:31 will be transformed to the value of 391 (for “Minutes_since_00:00” format) and to the
value of 23,460 (for “Seconds_since_00:00” format). This transformed value will be send to the tag.

M Get _tag_value - this action enables to listen to a specific tag value by phone. After you click the action
code, the tag name and description is played (as recorded by you in the file DIALxxx, where xxx is the action
code). After your confirmation U.C.ME will get the tag value, and will play it to your phone.

M Run_Program - this action enables the user who dials in to run a specific program. When choosing the
Run_Program action the following fields are displayed:

Program to run - the name of the program file you wish to run. You may locate the path of this
program by clicking on the Browse button.

Parameters - parameters for the program to run.

Start in - the path were the program will run.
For example: C:\MyFolderName.

M Action_Program - this action enables the user who dials in to execute up to ten actions without having to
enter the action numbers during the incoming call. When choosing the Action_Program action the following
fields are displayed:

Actions - Ten actions' numbers. Please note that the Action_Program action number can not be included
in one of the possible ten action number fields.

To clear the action numbers click on the Clear button.

= D Action type

” |D11 |Acti0n_ngram j

Actioh

IDD1 IDD2 IDDB IDDd IDDE IDDB IDD? IDDE IDDS ID'ID Clear |

This action enables the user who dials in to restart the computer. This action is identical to the Windows
Shutdown process when you choose to restart the computer.

M Suspend_Dial-out - This action enables the user to dial into U.C.ME and suspend all dial-out operations.

M Resume_Dial-out - This action enables the user to dial into U.C.ME and resume all dial-out operations.



Incoming SMS messages

You may use Incoming SMS messages for sending command to your application, or, for information
retrieval.

U.C.ME waits for incoming SMS messages. Once a message is received, U.C.ME identifies the sender via
the Caller-ID that is included in the message. U.C.ME verifies if this phone number is defined in U.C.ME's
phonebook. If not, the command is rejected. If the phone number is defined, U.C.ME will check if this user is
authorized to perform the specific action. As described in the Phonebook section, each SMS user has its
own authorizations for SMS commands.

Once the user is found authorized, the command is identified by the received text. If the received SMS text is
identical to one of the defined SMS commands, U.C.ME will process the action that is correlated to this text.

Here are the modems that support bi-directional SMS communications and incoming SMS messages:
¢ Wavecom - Fastrack (GSM)
e Siemens - MC35/TC35 (GSM)

The Incoming SMS window:

F SMS message designer P[] 3

k3

rSMS properti

SMS ent IHEStEﬂt computer Message format is free text

Achion RestartComputer B
Parameter 1 INULL

Parameter 2 INULL

¥ Send acknowledy to sender

Sh5 tert | Actioh | Parameter 1 | Param

Tum main air-condition uinit N ChangeT agWalue AIR-COMD-OP 1

Get set-point value GetT agy alue SET-POIMTI MULL Add
Fun Calculatar FunProgram CWWIMNT wspstemd...

Festart computer RestartComputer HULL MULL

Suspend alam notification SuspenddlarmMotifi..  MULL NULL Delete

Change

Save | Cancel

® Send acknowledge to sender — when set, U.C.ME will send the user an SMS message containing
information about the execution status.
For example: "Done" or "Command failed!"

i

5




SMS Actions

The actions below are similar to the actions used in the previous section - Incoming Phone calls. Please look
ate the definitions in the previous section.

] ChangeTagValue

[ ChangeTagValuelnteractive
V] GetTagValue

M RunProgram

] RestartComputer

M SuspendAlarmNotification
] ResumeAlarmNotification

Note: Try to define SMS commands with text length shorter as possible. Maximum SMS length is 70
characters. When verification messages are requested, additional text may be appended to the SMS
(sent back to the user): "Done", "Command failed!" etc...

Alarm acknowledge via incoming SMS

Alarms may be acknowledged in one of the following ways:
1. Returning the alarm text back to the cellular modem. (In this case, the alarm ID must be included in
the alarm text. See Options »Settings window in the SMS tab).
2. Sending the following text to the cellular modem: ACK NNNNN (where NNNNN is the alarm Id)

Acknowledge information is added to the daily log file and may also added to the SQL database (depending
on your settings).

Acknowledge operation may be used to stop alarm notification via SMS (depending on your alarm definition
properties — see SMS delivery options above).



Server shutdown/up notification

U.C.ME may send messages in one of the following cases:
1. When U.C.ME starts its execution.
2. When it looses connection with the OPC/DDE server.

Set the appropriate field in the window below. In addition translate the appropriate text that will be sent via
SMS. If you are telephony, you may record a voice message using the microphone button.

In most cases, the SCADA application should run 24x7. It should not stop in any case. When the SCADA
software (or the OPC server) is not active (from any reason) - no alarms will be generated. U.C.ME can
detect such cases and will automatically dial and play the appropriate message. (The voice file
"serveroff.wav" is played in these cases)

When you are notified on such a problem, you must restart your SCADA application and U.C.ME.

Recipients

M SMS Delivery method - U.C.ME may send SMS messages in one of the following methods:
1. Send the SMS to all recipients included in the recipients list.
2. Stop sending the SMS after successful delivery to one of the recipients (successful delivery means
that U.C.ME received confirmation from the modem/server that the message was successfully sent).
3. Send the alarm to one recipient, wait XX minutes for acknowledge. If acknowledge was not received,
send the alarm to the next recipient etc... If acknowledge was received, stop the SMS notification.

' OPC/DDE Server Shutdown notification x|

Recipients T Telepharny T General

Diavid.G.i@Phone

Clear List

Mark B@EMS £

Mike@Phone

Mike@Email Delete |

PaulE@sms 4| SMS delivery method

" Send SMS to all recipients

" Stop SMS notification after successful delivery bo server/modem

ﬁ ﬁﬁﬁ f* Stop SMS notification after recipient acknowledge
o wait 2 inutes bef t notificati
iBrowse Becipients, .} Browse Groups. .. 2 lebes el e

Save | Lancel |

Telephony

M Dial To - Define the users who need to receive the "Server shutdown" call. Define the "Dial To" to "One"
or "All". If "One" is selected, U.C.ME will stop dialing after one from the list have received the voice alarm. If
"All" is selected, all the people in the list will receive the voice alarms.

This property refers to phone recipients only. All other recipients (SMS, Fax, e-mail) will receive the alarm in
any case.

1 Ask for Password — for phone recipients only. When set, a phone recipient will have to enter his
password at the beginning of the call.




General

1 OPC/DDE Server Shutdown notification x|

Fecipients T Telephaony T

v Automatic notification after OPCADDE server sutdown

Text: ISBWBI;"SD&DA is niot activel @

[~ Automatic natification at L.C.ME startup

Test: |L|.E.ME iz active. E
Mumber of retries |5

[ Play alarm to local loud-speakers

Save | Cancel |

] Number of retries - The number of time U.C.ME should try to send the alarm in case of an error. This
parameter is applicable for Phone, Fax and SMS recipients.

M Play alarm to local loudspeakers — When set, U.C.ME will play the alarm voice file to the local
loudspeakers (the file name is serverof.wav).

M Automatic notification after server shutdown — when set, U.C.ME will generate the server shutdown
alarm.

[ Automatic notification after U.C.ME starts — when set, U.C.ME will notify the recipients that it was just
started its operation.



Special Days handling

U.C.ME enables administrators to plan when and who should receive alarms during special days and
holidays.
Click on Design» Special days to view the Special-days window:

EB Special days

Hovember 2005 Hovember 2005 v

=
Mon | Tue | Wed | Thu Fri Sat_| sun

31 1 2 3 4 5 B

7 5 9 10 11 12 13

14 15 16 17 15 19 20

21 22 23 34 26 7

28 29 30 1 B [z 4

5 6 T 8 [a [10 11
Description Select day pattem:
Labor day [ Special_Day_t1 3

Patern [ Description |
Special Day 1 Labar day

Special Day 2 Wacation

0341172003 Special Day_3 Trip to France

Delete

Change: |

[o=

Save Cancel |

To define a special day, choose a date in the calendar, type its description and select its pattern. A pattern
may be one of the following values:

Friday

Saturday

Special_Day_1

Special_Day_2

Special_Day_3

When U.C.ME's Run-Time module finds that a specific date is a special day, it will operate accordingly.
When an alarm occurs, U.C.ME will notify users according to their special day definitions. See the section
Phonebook — Time and day settings.



Recording and Playing WAYV voice files

U.C.ME provides you an easy tool for recording and playing WAV files. This tool uses the multimedia card
installed in your PC and microphone. Select a file and click on the "Play WAV", "Record WAV" or "New
WAV" buttons.

<t Select voice file... j x|
File

[ Prefix Filter I [~ Show system files

I ame I Size Tupe I Last modified ]
@ 3rd_floor way 11082 Private 18-4pr-06 12:40:52 P
ﬁ.ﬁ.ll.wav 13838 Private 12-Feb-06 12:51:20 P
QE bucket_brigade_int2 wav 44154 Private 12-Feb-06 8:28:44 P D

= Diall 00, wav 17-Apr-06 5:31:18 PM

JE Diall 01 warv 27618 Private  17-Apr-06 5:33:57 PM _ MNew'Why.. |
QE Diall 02, wavw 71714 Private 17-Apr-06 5:39:30 PM =
ﬁ Diall 03 ware EE202 Private 17-Apr-06 5:40:37 PM G@E
SEDial 04 way 55178 Private 17-Apr-06 5:47:40 PM i
QE Diall 05.way 24862 Private 17-tpr-06 5:42:21 P ﬂ
ﬁ Diall 06.way 24862 Private 17-Apr-06 5:42:37 P |-
ﬁ Diall 07 way 30642 Private 17-Apr-06 5:43:03 P 2
ﬁ Dial1 08, way 30374 Private 17-tpr-06 6:02:08 P Fecard Wil
ﬁ Dial109.way 24862 Private 17-4pr-06 B:02:54 PM -
ﬁ Dial 100 way 2VB18 Private 17-Apr-06 B:03:10 P
ﬁ Dial 171 way 35856 Private 17-Apr-06 B:10:26 P
@ Dial 12 way LY Private 17-Apr-06 6:11:02 P
@ Dial 13 way 24106 Private 12-Feb-06 1:53:30 P
JEDial 14 wav 24862 Private 03-4pr-06 5:14:52 PM LI

Ok LCancel |

™ Prefix filter
To show a subset of the voice files, you may check the Prefix filter checkbox and type a string in the text
field. U.C.ME will display the files that meet the filter criteria.

#5 Select yoice file...
File

[+ Prefiz Filker dial

I ame | Size Type Last)
RE Driall 00, waw 44154 Private 17-Ay
'-'»E Dial o way 27618 Private 17-47
RE Dall 02 waw 1714 Private 17-Ay
RE Diall 03 waw BE202 Private 17y



M Show system files

U.C.ME installs a set of system voice file. In most cases there is no need to change these files. To rerecord
these files, you first need to display them in the list. To display the system file, check the property Show
System files. The following files will be display:

#% select voice file... x|
File:

[~ Prefis Fiter | Vi

I ame I Size Type I Last modified ]

= Doway 7184 Private 05-b ap-05 5:55:55 Ak |

& 00.way V164 Private 05-b ap-05 5:55:55 Ak

@ 01 .wav 4024 Private 05-b ap-05 5:55:55 Ak D

@ 02 wav 3464 Private 05-b ap-05 5:55:55 Ak

& 03.wav B164 Private  05-May-05 5:55:55 AM New WAY. ..
= 04 wav G042 Private 05-kd ap-05 5:55:55 Ak

= 05 way a144 Private 05-k ap-05 5:55:55 Ak @

= OE.wav Ea44 Private 05-kd ay-05 5:55:55 Ak

& 07 wav E784 Private 05-k ap-05 5:55:55 Ak ﬂ
= 08.wav 3384 Private 05-k ap-05 5:55:55 Ak

= 09.wav BE24 Private 05-k ap-05 5:55:55 Ak @

= 1.way hav2 Private 05-k ayp-05 5:55:55 Ak Fecord Wi
& 10.way 4504 Private 05-bd ap-05 5:55:55 Ak -
&= 11.way 7344 Private 05-bd ap-05 5:55:55 Ak

= 12.way 20323 Private 05-b ayp-05 5:55:55 Ak

& 13way 9063 Private 05-k ayp-05 5:55:55 Ak

= 1d.way 10412 Private 05-b ap-05 5:55:55 Ak

G 15.may 10244 Private 05-bd ay-05 5:55:65 Ak LI

Ok LCancel |

To rerecord a system file, select it and use the mouse right button. The following menu will be displayed:

MeEw, .. Chrl+M
Flay Ckrl+P
Record Ckr|+FR

Change type  Chrl+T

Delete

Use the Change type menu item to change the voice file type from System to Private. Once the file is
Private, you may rerecord it. After the file was rerecorded, you may change its type to System again.

Private files are marked with the following icon:

=

System files are marked with the following icon:



When recording files, U.C.ME launches the Windows™ Sound Recorder program. By using a microphone
connected to your sound card, you can easily record new voice files.

@ hello - Sound Recorder o ] |

File Edit Effects Help
Puoszition: Length:
2.00 zec, 2.75 sec,
|
1]

|| » |

Click on the "Refresh list" button to view the newly created voice files in the list.

Note: Make sure not to change the file "empty.wav". This file is used as a template for every recording.

Improving WAV files quality
Recording with Microsoft Windows® Sound recorder utility, you may change the audio properties to improve
WAV file quality. Click on Edit » Audio properties. The following window will be displayed:

Audio Devices |
i~ Sound Playback
Q’U Preferred device:
5 gundM &%, Digital Audio
WVolume Advanced I
i~ Sound Recording
ﬁ Preferred device:
[SaundMe Digital Audio =l
Wolume Advanced I
i MIDI Music Playback.
g Prefered davice:
22 5 oundMAX WM MIDI =l
alume Abaut I
™ Use only preferred devices

0K | Cancel | Apply |

Click on the Volume button inside the "Sound Recording" frame. The following window will be displayed:

EE Recording Contral 10l x|
Options  Help
CD Player Microphane Line In
Balance: Balance: Balance:
Walurne: Wialurne: Wolume:
[~ Select W Select I~ Select
Advanced |
|SoundMA>< Digital Audio




Set the volume to the maximum. In addition you may click on the "Advanced" button. The following window
will be displayed:

Advanced Controls for Microphone x|

i These settings can be used to make fine adjustments to your
|" audio.

i~ Tone Contral

These settings cantrol how the tone of wour audio sounds:

Bass: L J— High

Treble: Lo J— Highr

i~ Other Contral

These settings make other changes ta how your audio sounds. See
your hardware documentation for details.

¥ 1 Microphone Boost
[~ 2 Front Panel Microphone

Close

Set the "Microphone Boost" to improve the volume of your recorded voice files.



User Authorization

U.C.ME enables the system administrator to define users with different authorizations. Use the Design»
User Authorizations menu to enter the User Authorization window. The following window will be displayed:

f User Authorizations )

Fuill M arne IMichaeI

Department ISaIes

U sername Iq
Pazzword Ix

Fazzword expiration——————

+ Never

™ Eweny ID daps

 Uszer iz dizabled

Inactivity timeout

IU mirLbes

rOther

-Design men
v Zlamns

v 2lam Families

v Alam Feports

v Alarm Group names
¥ Groups Defirition

¥ Incoming Phone calls

¥ Phane Book

¥ Shilts Definitions
¥ Special Days

v User duthorization

W Incoming M5 messages

v Server Shutdown/Up calls

W Fecord and Play 'Wave files

e
¥ Alarm Snapshats

¥ U.C.ME Home page
¥ Telephony Statistics
¥ Show Tip of the Day

¥ Bun-Time
¥ Send Meszages

rLog File
¥ Email Lag

¥ Alarm Snapshat Log
¥ OPC Log

¥ DDE Lag

¥ L.CME Log

v LL.C.ME Emars

Iv Audit trail

~Tool

¥ Backup to ZIP
v Restore from ZIP

~Optian
v Diglogic Phone lines
¥ Settings

¥ 5SS Protocaols

aK

Setal

Rezet All

x|

H Cancel |

Properties:
Full Name — The user's name that will be used for
Department — The user's department name. (For exemple: Administration, Maintenance, Etc....)
Username — The name the user needs to use when he logs in.
Password - The password the user needs to use when he logs in.
Password expiration — Choose between one of the following:
Never — The user's password never expire.

Every __ days — The user's password expires after XX days. When the user will try to log in after his
password expired, he will not be able to log in. The administrator will have to provide him a new
password.

User is disabled — The user will not be able to log in.

Inactivity timeout (in minutes) — when a user is logged in without any activity (keyboard hits, mouse
movement) he will be automatically logged out.



Once users were created, each user will have to log in to perform any change in the U.C.ME application or
view reports. Once the U.C.ME-Configuration program was launched, all the buttons in the tool bar and all
the menu items will be disabled. See below.

Configuration - U.C.ME-OPC [Server=http://localhost /UCME-OPLC/] User= ]

File Logfiles Design ©Options Yew Tools Help Fum-Time!

To log in, the user will need to click on the login button. The login window will be displayed:

x|

Uzer Mame: |B.;.|:.

Bazzword: |*****>1

Cancel |




Log files

Configuration Audit Trail

U.C.ME keeps electronic records of every operator action (change in alarm configuration) electronically
signed with explanatory text and securely logged to a proprietary format database.

To view the database click on Log Files » Configuration Audit Trail. The following window will be

displayed:
x
[rate Filter |l zer Filke
From To

Menth |05 | o5 ] | |

Year |2005 | R ey
D | Time Stamp I Uzer Mame | Ewent Test | Uzer Comments ;I
74 2006/05/0411:29:34  Michael Alarm Motor Mumber 3 haz low oil' modified.
75 2006/05/0411:23:39  Michael Alarm "Motor Humber 4 haz overheated' modified. - AL, Michael: Alarm condition wagz
7B 2006/05/0411:29:43  Michael Alarm Motor Mumber 4 haz overheated' modified. - Al..
I 2006/05/04 11:25: 44 Michael Alarm "Motor Humber 4 haz overheated' modified.
78 2006405404 11:3357  Michael Alarm "Motor Mumber 1 has overheated' modified. - R...  Michael: Meed to zend alarm t
74 2006/05/0411:2358  Michael Alarm "Motor Mumber 1 haz overheated' modified.
a0 2006405404 17:40:04  Michael Incoming Phone call command 101 Get_alarms_log' ..
a1 2006405404 17:40:04  Michael Inzoming Phone call command 101 Get_alams_log' ..
a2 2006405404 17:40:04  Michael Incoming Phone call: commands - sawved.
a3 2006/05/04 133618 Michael U.C..ME-QPLC Configuration was terminated.
a4 2006405404 14:29:24 U.C.ME-OPC wersion 60101 was started J
a5 2006/05/04 14:25.32  Michael ‘Michael' logged in. Michael: Micahel loged into o
a6 2006/05/04 14:22:04 1.C.ME-QOPC vergion 6.0.101 was started
ar 2006/05/0414:2217  Dawid 'David' logged in. David: David logged in to cha
a8 2006/05/04 14:34:48 David U.C.ME-OPLC Configuration was terminated.
29 2006/05/04 16:29.53 I.C.ME-OPC version B.0.107 was started i
; = e I _LI_I

Done

HTHL report

| Mumber of records; 113

The default date range is the current month. To view another date range select the "From" month and year
and the "To" month and year. Click on the Refresh button to view the required date range.

U.C.ME displays all users' activities. To filter one user's activity, select a user using the User Filter field and
click on the Refresh button.

HTHL report

To view the report in HTML format, click on the HTML report button.




Configuration Audit Trail - Adding users’' explanatory text

The user may add his comments and explanatory text for the events (changes) by double clicking on any
event. The following window will be displayed:

x

Ewvent Information

ID: 72
Tirne: 2006/05/04 11:39.57

deer: Michael
Event: Alarm Mator Humber 1 has overheated' modified. - Recipient added: Mike@E mail
I

4|

Uzer comments

Ilzer Hame Text
Azled by Mike o zend hirm alarm email as well
Meed to zend alarm to phone recipients as well,

Timne Stam

200605404 11:41:14
2006/05/04 131112 Michael

<

Izer comment |

LCancel

\_ lgx IL

Users may add up to five users' texts. To add a text type the text in the User comment field and click on the
"Add" button. Each text is added with the time stamp and an electronic signature of the user.

Note: Users' texts can not be deleted!



Email Log

U.C.ME's email thread logs its activity to a log file. The file name is: "SendEmail.log". This file can be also
viewed with any text editor.

Alarm Snapshot Log

U.C.ME's Alarm-Snapshot thread logs its activity to a log file. The file name is: "AMI.log". This file can be
also viewed with any text editor.

OPC Log

U.C.ME logs the OPC servers' activity to log files. Each server activity is logged into a different file. The file
naming convention is: "OAlnn.log" (where nn is the OPC server index). These files can be also viewed with
any text editor. The files are located in the main U.C.ME folder.

DDE Log

U.C.ME logs the DDE server's activity to a log file. The log file name is ddeal.log.

U.C.ME Log

U.C.ME logs its activity to daily log files. The file name convention is: "UCMEyyyymmdd.log". To view the
files, click on the Log Files U.C.ME Log. The following window will be displayed.
Double click on a specific date or a specific file to view the log.

x
V¥ Choose date filter
+|  Marchz006 |
ES| |
B0 2\ 1 2 3 4 JCMWE 20080307 .LOG
5 B 7 8 9 10 N JCME 20080308, L0G

JEME20060319.L0G

12 13 14 15 16 17 18
19 20 A1 22 23 24 25

ICME 20060321.L0OG
225 23? 248 259 EED 3?1 13 CME 20060322 LOG
CME20060323.L0OG

3 Today: 20-Apr-06 JCME20060324.L00G LI

Wiew Log | LCancel |

The files can be also viewed with any text editor.

U.C.ME Error Log

U.C.ME logs all the errors to an error log file. The file name is: "UCME errors.txt". This file can viewed with
any text editor. In addition, it can be viewed via the Configuration program's menu items (View » U.C.ME
errors).



View

Telephony statistics

U.C.ME writes all its dialing and communication activities to history files. To view the statistics, click on View
» Telephony statistics or on the appropriate button in the toolbar. The following window will be displayed:

72 Statistics

Date range

Frarm 2003/04415 To 200341147

Date

Alarns Calls

Confirmed

Hot-Ans.

2003/04/15

25

2003/04/28
2003/04/29
2003/085/05
2003/05/06
2083/18/25
2003/18/26
2003/11/17

Total

Delete Statistics

21

@O0~ om 2@

117

(LRI

11 48

| Lreate report |

oo oW

18

32
26
1

1
a
a
1

86

The Statistics window contains the following information:

Date — One day date.
Alarms — Number of alarms generated at that date.

Calls — Number of calls U.C.ME initiated at that date.
Confirmed — Number of calls confirmed by the users (SMS or Phone)
Not answered — Number of phone calls not answered.

The Total shows the totals of each column.
You may delete the statistics by clicking on the "Delete Statistics" button.

You may create a report for a different date interval. Click on the "From" and "To" date buttons to set a
different date range. Then click on the "Create Report" button.

Alarm snapshots

To view alarm snapshot history, click on the "View » Alarm snapshots" menu item. The internet explorer
will be opened displaying the alarm snapshot database. For more details see the "Viewing alarm
snapshots using the web" chapter ahead.



Tip of the day

Tip of the day is automatically displayed when starting the U.C.ME-Configuration program. To disable the Tip
of the day window at startup, uncheck the Tip of the Day menu item.

See below sample tip:

]
@ Did pou know. .. 4|

That you can stop the SkS alarm notification after one
recipient haz acknowledged the alarm’? Alarms are
acknowledged by zending the text "ACK, nnnnea' [Annnm
iz the alarm 1d) to the cellular modem.

¥ Show Tips at Startup




Tools
Backup to ZIP files

U.C.ME makes it easy for you to back and restore the applications files. Click on Tools »Backup to ZIP to
create a backup of your application. The following window will be displayed.

x
H
Select files to backup...

-[# D ata files

[ Log files
w ] Waice files
rlnfarmatior

Files created by |1.C.ME-Configuration: Alarm definitions;
|Jzerz; Recipients; Incoming SMS; Incoming phone calls;
General zettingz [*.0AT, =ALR, = ADE]

Start | LCancel |

Select the file types you wish to backup and click on the Start button. The following message should be
displayed:

]

D:\Program Files\Control-See\UCME-OPC-DDE 5.6 BACKIUPYConfiguration files 04-20-2006 14 33 46.2IF Created Successfully




Restoring from ZIP files

To restore U.C.ME application files, click on the Tools » Restore from ZIP menu. The following window will
be displayed:

B Restore from ZIP files x|
~Files b tore
L [rate | Timne | File name
@ 03-15-2006 2310:55 Configuration files 03-1

@ 03-16-2006 03:11:29 Configuration files 03-1
2] 04-20-2006 14:33:46 Configuration files 04-2 Besiors |

" Log files
" Vaice files

<] | 1|

| nformatior

Files created by U.C.ME -Configuration: &larm definitions;
|zers; Recipients; Incoming S5 ; Incoming phone calls;
General zettings [*.DAT, “ALR, *ADE]

Done |

Select the file types you wish to restore and click on the Restore button. The files will be restored to their
original location.

This is a convenient tool for system integrators to move the application from their office PC to the customer's
PC.

The files are located in the BACKUP sub-folder of U.C.ME. You should always place your U.C.ME ZIP files
in this folder.



Recording and playing VOX and WAV files using
telephony

Recording can be also done via the U.C.ME's console utility called WVMULREC (Multiple File Recording).

This utility uses the Dialogic board and a telephone line for recording. To use this utility connect the
telephone line to the board and click on:

Start® » Programs » Control-See » U.C.ME » Record Voice Files

The WVMULREC utility waits for an incoming call from line 1(the default). Use a standard phone and dial to
the appropriate number.

The WVMULREC will answer the call and will ask you to type the voice file name. After you type the voice file
name, press on the <Enter> key. Then, you will hear a beep that instructs you to start the recording.

To terminate the recording, click on any of the phone’s keys.

The WVMULREC program will ask for a new file name. You may enter a new file name or press <Enter>
(with empty file name) to abort the recording (see below). The default voice file format is WAV. If you wish to
record VOX files, please modify the properties of this utility and add the word VOX after the channel number.
For example:

WVMULREC 1 VOX

The WVMULREC window

% WVMULREC
B2 - | B e Al

G : “\WINDOWS >doskey

DOSKey installed

Gz \WINDOWS >

IC:\UWINDOWS >e =

E:\W/-Uo ice DDE\NDEMONEXCEL>uunulrec 1

WUMULREC — Wuoice multiple file record utility version 1.880
A1l Rights Reserved. Control See 1995.1996 <cd

Opening device channel: dxocBlCl
Uoice Files directory is: \w-voiceDDE\wox_h

Waiting for incoming call...

To end the recording, click on any of the phone’s keypad.



Creating alarms via 3" party programs

U.C.ME may also receive alarms that are generated by other programs.
Such programs can create ASCII files that can be read by U.C.ME.
The program should create ASCII files with the name format ASCalarm.” (any extension name is valid).

U.C.ME will search for these files in every rounded minute. If a file exist (For example: ASCalarm.000,
ASCalarm.002, ASCalarm.0083 etc...), U.C.ME will read this file, create the alarm and delete the file. Each
file defines one alarm.

The program that creates the alarms files should check if such file exists before it tries to create it. If the file
exists, this means that U.C.ME didn’t read this alarm file yet. In this case the software should choose
another name for the file.

The file format is shown below:

Line 1: Alarm description (up to 70 characters)

Line 2: N (N may be 1 or 0. 1 stands for "Start Alarm" while 0 stands for "End alarm")
Line 3: "Number_of_calls X" (where Xis the number of recipients)

Line 4: Recipient_name_1

Line 5: Recipient_name_2

Line X+6: Recipient_name_X

Line X+6: "DialToOneOrAll Value" (where Value may be "One" or "All'. Use "one" when you want that U.C.ME will stop dialing after
one person received and acknowledged the alarm. This option is applicable for Phone users only.

Line X+7: "NumberOfRetries N' (where N is the number of call retries U.C.ME will do in case of busy line or no answer)

Line X+8: "AcknowledgeAlarm N' (where N may be 1 or 0. The value 1 will instruct U.C.ME to ask the user to acknowledge the alarm)
Line X+9: "AskForPassword N' (where N may be 1 or 0. The value 1 will instruct U.C.ME to ask the user to enter his password at the
start of the call)

Line X+10: "AlarmVoiceFile Name" (when Name is the voice file name. For example: use "fire" when the voice file name is "fire.wav")
Line X+11: "LoudSpeaker N" (where N may be 1 or 0. The value 1 will instruct U.C.ME to play the alarm voice file to the external
loudspeakers)

Line X+12: "EndOfCallAck N" (where N may be 1 or 0. The value 1 will instruct U.C.ME to ask the user to verify the end of the
phone call by pressing the # key)

Note:

1. Recipient names must be in the following format: Name@Phone , Name@Fax , Name@SMS
Name@Email. The recipient's Name must be the same name as displayed in U.C.ME
phonebook.

2. Please make sure that the tokens included in the recipient's name -"Fax", "SMS", "Email" and
"Phone" must appear exactly as shown above!

3. Recipient name may be a group name. For example: $Group1, $Group2 etc...Group name must
have the same name as defined in U.C.ME's groups definition window.

4. U.C.ME will handle external alarms disregard shifts definition. This means that the alarm will be
sent to the recipient list according to the standard time and day settings for each user.




Example for alarm file:
Pump B71 malfunction
1

Number_of calls 5
Mike@Phone
David@SMS

Jim@Email

Ben@Fax

$Groupl

Dial_To All
NumberOfRetries 5

AckAlarm 0
AskPassword 1
Alarm_voice_file firel
LoudSpeaker 1
EndOfCallKey 1

See the sample files in the U.C.ME Samples folder.



Sending messages

U.C.ME enables users to send textual and voice messages to Fax, SMS, E-mail and phone in a very simple
and convenient way.

To launch the Send Message utility click on:
Start # » Programs »Control-See » U.C.ME »Send Message

The following window will be opened:

%l U.C.ME - Send message ) ;IEIEI

File Tools Wiew Help

4 Recipients/Groups in list

Uzer name I Phone number/E mail I Paging system I 5MS protocol ﬂ
; Mike QF2RAE242622 SMS G5M-Maodem i
8 : Browse Recipients...
[¥58 D avid G 2127643587 Phone =
; Mark.B 818643580755 SMS Cellular-TEXT
g Faul 2187778080 SMS Cellular-TEXT
Browse Groups...
Clear list
-Flcice Send I Voice
High pricrity meszage - force zend to all recipients
B Y

-5MS delivery method

Send to: -
{* Send SMS to all recipients see IA” J
[T Ask for password

[T Acknowledge required
[T Ak for # tovernty "Endi@F Call
[~ Flay to loudspeakers

{~ Stop SMS notification after successful delivery to server/madem

{~ Stop SMS notification after recipient acknowledge

W it IU minutes before nest notifization

Flease tvpe the meszsage text... [25 characters)

ITest messane from LLC.ME | j Long mezsage |
Send | Dione |

Drag and drop users and group to the users' notification list.
If you wish to send voice messages via voice, record a voice file or select one from the list. In this case, you
should also set the following fields:

e Send to: One or All

e Ask for password

o Acknowledge required

o Ask for '#' to verify End of Call

¢ Play to loudspeakers

e SMS delivery method

If you wish to send textual message, enter the message text or select an existing one from the list.




U.C.ME Run-Time module

The U.C.ME run-time module is an OPC or DDE client. It is an event driven module. It doesn’t consume
CPU time, it doesn’t scan any database and therefore it can maintain a large number of alarms without
harming the overall application performance.

This module is multi-tasking and multi-threaded software. It was designed to run on the Microsoft® Windows
XP/2000 and Windows 2003 Server.

U.C.ME operational modes

There are tow operational modes for U.C.ME-
= Service mode
= Standard application mode.

U.C.ME running as a Windows service

Depending on the chosen setup type (service or standard), U.C.ME may be installed as a Windows service.
The service's Startup Type is set to Automatic. To view or change the service properties you may use the
Service Control Manager (Start» Settings» Control Panel» Administrative Tools» Services). The
following window will be displayed:

Services ) o ] |

| action  view |J4--r| |||§Hbl|l m |
Tree I Mame / | Description | Skatus | Skartup Twpe | Log On As | :I
% Services (Local) %TCP,I'IF' Prink Server Provides a ... Manual LocalSystem
%Telephony Provides T...  Started Manual LocalSyskem
Telnet allows are... Manual LocalSyskem
JCLME-OPC Bun-Ti,,. ULC.ME-OP,.. Marual ]
%Uninterruptible Pow... Manages a... Manual LocalSystem
%Utility Manager Starts and ... Manual LocalSystemn
%'-.-‘isual Studio Analvz. .. Manual LocalSystem
%Winduws Installer Installs, re... Manual LocalTystem
%Windnws Managem... Providess,..  3Started Automatic LocalSyskem
%Windows Managem... Providess...  Started Manual LocalSyskem
%Windnws Time Sets the ca... Parual LocalSyskem
%Wireless Configuration Provides a... Manual LocalSystemn
%Wunderware NetDD... rarual LocalSyskem
%Wnnderware SuiteLink. Started Autornatic LocalSystem
%Wnrkstatiun Provides n...  Starked Automatic LocalSyskem
%w::rld Wide Web Pu... Provides'W... Started Autornatic LocalSystern
-




To modify the service properties select the U.C.ME-OPC Run-Time service, click on the mouse's right
button and select Properties. The following window will appear.

U.C.ME-OPC Run-Time Properties (Local Computer) x|

General |Log Dnl Hecweryl Dependencieal

Service name: JCME-Service

Display name: L.C.ME-OPC Bun-Time

[rezcription: U.C.ME-OPC Service

Path to executable:
[:“Frogram Filez\Control-S ee\UCKME-OPC-DDEABIM \ucme-it exe

Startup type: Autormatic j

Service ztatus: Stopped

Start | Stop | Pauze Eesume |

ou can specify the start parameters that apply when you start the service
fram here.

Start parameters: I

Ok, I Cancel Apply

U.C.ME-OPC Run-Time service's Startup type is set to Automatic. This means that it will automatically start
when Windows is starting. You may change this property to Manual if you wish to start the U.C.ME service
manually.

Using the U.C.ME Service/Application Configuration program, you may select dependency services for
U.C.ME. Dependency services are services that need to run before the U.C.ME service is running.

Once the dependency services are set, you may see the dependencies in the Dependencies tab. The
following window will appear.

U.C.ME-OPC Run-Time Properties (Local Computer:

General | Log On | Recovery Dependencies

Some zervices depend on other services. If a service iz stopped or iz not
unning properly, dependent services can be affected.

"U.C.ME-OPC Run-Time" depends on these services:
Dialogic:
% M atrikon OPC Server for Simulation and T esting

+

Thesze spvices demend am UHEE M E-RRE Bion-Timet



Starting and stopping the U.C.ME service

Another way to control the U.C.ME service is by using the U.C.ME Service Manager. Click on
Start #» Programs »Control-See » UCME-OPC » U.C.ME Service Manager.
The following window will appear.

Eu LL.C.ME -Service Manager El

Serice: ILI.I:.ME-I:IF'I: Run-Time
Start
% [ ] | Stop

U.C.ME Service status: Stopped

Click on the start button to start the service.

Click on the start button to start the service.

When the service is running, the following picture will be displayed:

When the service is stopped, the following picture will be displayed:




U.C.ME's run-time window

E& U.C.ME - Unified Control MEssaging
File Alarms Loudspeskers Wiew Help

111219 nfo]ldlarm 32][1] Dialing to: MikeE@Phone Phone: TOBE24 2622

On-Hook

On-Hool,

On-Hook,

11:10:18[Info] S5 Pratocaol is Cellcom(De410]

On-Hook,

3
B
0
)4
5

11:12:16[Error] The ‘Advanced Direct Remailer' program iz not running!

|

Lag windaw:

11:18:48[Eror] The ‘hdvanced Direct Remailer' program is not winning!

11:19:1 2[Info]Reading alarm definition file AIRCOMDO0Z2

11:19:1 2l nfo)[dlarm 32 Ended] 111703 ; Air-condition main unit - hot water - temperature too highl
11:19:1 2[Info] Reading alarm family file AIRCOMD

11:19:16]Info]Reading alarm definition file AIRCONDO0Z

11:19: 16 nfalfdlarm 32 Started] 1117403 ¢ Air-condition main unit - hot water - temperature oo highl
11:19:16[Info] Reading alarm family file AlRCOMD

11:19:16[Info]fdlarm 32] Sending alarm email to ControlS eed@E maillmichamizicontiolzee, com).
11:19:16[E mmar] The ‘Advanced Direct Remailer’ program is not mnning!

11:19:18[Infa] Opening device desxB1C1 handle=1.

11:19:1 I nfo)ldlarm 32][1] Dialing to; Mike@Phone Phone: TOBE

|F‘h0ne,l'Fax Outbo: 0 calls |SMS Outbo 0 messages |Wa\-': 0 alarms

The U.C.ME Run-Time window may be used for the following options:
= View the last section of the U.C.ME log file
= Suspend alarm notification (using the Alarms menu)
= Delete all alarms from the alarms queue (using the Alarms menu)
= Suspend alarms replay (multimedia) (using the Loudspeakers menu)
= Delete all alarms from the multimedia alarms queue (using the Loudspeakers menu)
= Viewing the various log files (using the View menu)




Launching U.C.ME within other applications

The U.C.ME Run-Time program name is UCME-RT.EXE. You may find it in the U.C.ME BIN folder. You may
run this program within any other application. You need to ensure that this program will be running in the
right path (Usually: "C:\Program Files\Control-See\UCME-OPC"). To ensure that U.C.ME is running in the
right folder, you may pass the folder name as a parameter to U.C.ME Run-Time module (UCME-RT.exe).

Example 1: to automatically run U.C.ME-Run-Time from your Citect® application you should run the
following Cicode EXEC command. This Cicode function should run at startup.

FUNCTION RunUCME

Exec ("C:\Program Files\Control-See\UCME-OPC\BIN\UCME-RT.exe C:\Program
Files\Control-See\UCME-OPC", 1) ;

END

Example 2: to automatically run U.C.ME-Run-Time from any software that is able to launce a batch file, you
may use the following batch file:

@echo off

cls

c:

cd\

cd program files\control-see\UCME-OPC\

START "UCME-Run-Time" /MIN .\bin\UCME-RT.EXE
Exit



U.C.ME status icon in the system tray

L REHRS R T 1029w

Ca
When U.C.ME Run-Time module is running, the U.C.ME logo = appears in the Tool Tray, located by
default at the bottom right of the Windows desktop (see below). Clicking on the U.C.ME status icon will
display the U.C.ME Run-Time window on the desktop. This window may be closed (without terminating the
Run-Time) by clicking on the close icon (see below).

Note: If U.C.ME is installed as a service, the U.C.ME icon status may not be available in the system tray.

Clicking on the mouse's right button when the cursor is over the U.C.ME status icon will display the following
menu.

Abouk L, CME
Alarm History

Resktore

Trace LL.C.ME Log

Exit

Clicking on the About U.C.ME menu, will open the About window. The About window provides license and
version information.

Clicking on the Alarm History menu, will open Internet Explorer with U.C.ME's Alarm Snapshot login page.
Clicking on the Restore menu, will restore the U.C.ME-Run-Time window.

Clicking on the Exit menu, will display the following dialog box.

U.C.ME Exit x|

Exit: Are wou sure?

=9

es Mo | Cancel |

Clicking on Yes will terminate the Run-Time process. If U.C.ME is installed as a service, the service will be
stopped.



Debugging your U.C.ME application

Clicking on the Trace U.C.ME Log menu, will open the Tail.exe viewer which will enable you to trace the
daily log file and analyze your application. Using the Tail.exe viewer you can mark different key-word with
different colors. Click on Settings» Keywords and select the desired keywords. See below.

keywords x|
| Kepward | Enbur| De
¥ Start-alam Green
¥ Ermar Red
I® End-alam Blue =
—Add Keyword
Kepward: End-alarm Add

Once keywords were defined, all matching lines will be marked in the appropriate color. See below.

1 Tail for Win32 - [UCME20060407] B ]

File Edit “iew Setkings Pluginsg Tools  Window  Help
[

20:51:29[Info] Alarm reports not in use. _:J

20:51:29[Debug] Plug number is 0 e

20:51:29[Info] Model info - Alarm limit=5, Date limit=--/--/--

20:51:29[Infao] OpenCom(), Port name is COM1, port_handle=378fded

20:51:29[Debug] OpenComi(), after SetPortldleFunctionPtr...Before exit.

20:51:29[Info] ReadictionsFile - reading £ile 5M3actions.dat.

Z20:51:29[Info] ReadictionsFile- 3 actions defined.

Z0:51:29[Error] U.C.ME plug is missing! U.C.ME will work in demo mode and exit i

Z20:51:29[Info] Demo mode. T.C.ME will stop after one hour!

Z0:51:29[Info] TAP 3M3-Alarms thread started...Comfumber=0, Port=375Lded

Z0:51:31[Info] Woice f£ile format is TWAWV.

Z0:51:31[Info] 3pecial Days f£ile (specialdays.dat) does not exist.

Z20:51:31[Info] Alarm Snapshot - database type = Mi-Access

20:51:31[Debug] Deleting from WAV cqueue: front=0 rear=0 -r:J
k

4

Last updated; 03:54:35 |Last match: 0&;54:35 Total matches: 11 |

The Tail.exe program will always show the last part of the log file.



Viewing alarm snapshots using the web

The U.C.ME Setup program creates a virtual directory called UCME-OPC. This virtual directory may be
accessed using any Internet browser. Open any internet browser and type the following URL address:
http://localhost/UCME-OPC . The following page will be displayed:

-2} U.C.ME(TM) Alarm-Snapshot({TM} - Control-See Software Solutions Ltd. - Microsoft et | =10l =]

J File Edit ‘iew Favorites Tools Help ﬁ

J s=Back - = - (B ot | ‘Qhsearch [HlFavorites SiMedia o4 | By S -

| Address |@‘| hittp:  lacalhost/UCHE-ORC) ~| @ao “Links »
=

U.C.ME™ Alarm-Snapshot™

ez Click here to display the RSS feed

alarm

s View Alarm Snapshot history...

=3 Download an RSS Reader. ..

Control-See Software Solufions - Home

Control-See Software Solutions Ltd. All rights reserved. 1995-2005,

.
€l l_ I_ ’_ (2 Local infranet 4

Using this page you may choose to:

1. View the RSS feed. This feed may be used by any RSS reader software to display the alarms from
any computer in the Internet or Intranet. When clicking on this link, the following window will be
displayed:

3 http://localhost /UCME-OPC/LastAlarms.kml - Microsoft Internet Ex : = Ellzl

J File Edit ‘iew Favortes Tools  Help

J dBack » = - &) fat | Qysearch GFavorites GliMedia £4 | - 2 JNorton Antivirus & -
Jnddress I@j http: fflocalbost ICME-OPC fLastAlarms. xml j @Go |J Links > J Morton Internet Security &~
| Canon €asy-webPrint - | Eherint EhHighSpeed Print [Ty Preview | [Joptions [ Duplex

-

<7uml version="1.0" encoding="UTF-8" 7=
- <RSS version="2.0">
- <Channel»
<Title=New York Hotel - BMS</Titlex
<CopyRight=Copyright {c) 1994-2005 Control-See Software Solutions
Ltd. All rights reserved.</CopyRight>
<Link=http://localhost /UCME-OPC /read_db.asp</Link>
=<Description=U.C.ME - Advanced Alarm Snapshot</De=scriptionz
- «<Imagez
<Title=New York Hotel - BMS</Title=
<Width=70</width=
«<Height=35</Height=>
<Link=http://localhost /UCME-OPC/read_db.asp</Link>

When the feed (see above) is displayed, copy the URL field (for example: http://localhost/UCME-
OPC/LastAlarms.XML). Later on, you may use this feed in your RSS reader software.



http://localhost/UCME-OPC/LastAlarms.XML
http://localhost/UCME-OPC

2. View the alarm snapshot history. The alarms and events are stored in a database file called
"AllAlarms.MDB" (MS Access file). The alarms in this file can be viewed using this link. Click on the
"View alarm snapshot history" link and the following page will be opened.

3 UW.C.ME-Alarm Snapshots - Login - Microsoft Internet Explorer = 5'
J File Edt ‘iew Favorites Tools Help |

J GBack - =» - @ 74 | Qysearch [GFavorkes  EiMedia 4 ‘ - S A
| Address [&) httpisfiocahost {CME-OPC login. asp = e [|uks & >

B

U.C.ME™ - Alarm Snapshots - Login

Usermame: ezt
Password: s

Remember Pazsword: W

Control See Software Solutions Ltd. All rights reserved{1995-2005).

&
El

|&] Done ’_ ,_ ,_ E Local intranet 4

Enter your Username and Password and click on the Submit button. The default username is "admin"
and the default password is "admin". This default user has administrator rights. You may later change
this default user password to prevent users with lower access rights from using this username. A user
with administrator rights may create, delete or modify users that can view the database content.

The following window will be displayed:

localhost/UCHE-OPC/menu.asp - Microsoft Internet Expl

=1olx|

J File Edit “ew Favorites Tools  Help |

J GBack - = - D) tat | Qisearch [GFavorites Sfvedia <% | By S -
Jnddress Iﬁj http:filocalhost /UCME-OPC menu, asp j @Go |JL|nks S
Bl

Logged as guest  Log out

Alarm and Event

|
|@ Dane ’_ ’_I_ E Local inkranet v




Click on the "Alarm and Event" link. The following window will be displayed:

4} Alarm and Event - Microsoft Internet Explorer | =10l =l
J File Edit V“iew Favorites Tools Help ﬁ
J —Back ~ = - @ ) | @Search (] Favorites @Media @ | %v S =
| Address |&] hitp:flocalhostjUCME-OPCjAlarms _T_list.asp R |J Links @]oans oowey  @&]D-Link »
|
Table: Alarmand Event LU 0 [mmeemed U S @i
Search for: IAny fiiglcd LI IContains LI I Detailsgfound: Records Per Page:
Page 1 of 1 2
@ ID Date Time Status Category SubCategoryi SubCategory2 Description
Siewe 1 230672005 12:41:38  Start alarm  Production Cooling “alves ‘Water injection - valve iz open
Yiewe 3 230672005 124205  Start alarm Production Conveyors Speed Conveyor speed is too slow
Wiewy 4 230672005 124355  Start alarm  Production Pumps Started Transter pump iz started
Wiew 2 230672005 12:44:24  Start alarm Production Reactors Temperature Reactor C12 - tempersture too high
Wiewe 4 23062005 124855  End alarm Production Pumps Started Transfer pump is started
Yiewe 3 20672005 124911 End alarm Production Conveyors Speed Conveyor speed is too slow
Wigee 1 230652005 124934  End alarm Production Coaling Walves Witer injection - valve is open
Wiew 4 230672005 124959 Start alarm Production Pumps Started Transter pump iz started
Siewe 1 230672005 12:51:42  Start alarm  Production Cooling “alves ‘Water injection - valve iz open
Count: 9 LI

@ [T e

You may show all alarms or a sub-set. Use the "Search for" fields to select a sub-set.
Click on the "Show All" button to display all alarms in the database. Click on the alarm's description to
see its snapshot. The following window will be displayed:

3 -&napshot - Microsoft Internet Explorer =10 x|

JFilE Edit  View Favorites Tools  Help ‘

J R | 2 ‘ ‘Qisearch  [FFavorites  FMedia al 2%

| Address [@] http: ilocalhost JUCME-CPCfAlarm-20050623- 1241382 7 | (% Go HLlnks e

El

Start alarm 23/06/2005 12:41:38
Water injection - valve is open
Category - Production
Sub-Category 1- Cooling
Sub-Category 2- Valves

alve is Opened [Required=Closed)
'Water level is 13 Meters [Out of range (10-12)]
Status Auto

Dam Level

I A0 m

P
Available

P
Auyailable
Ground Water: High

|
‘@ Dione ’_ ’_ ’_ E Local intranet i




3. Download an RSS reader. Click on this link to download RSS reader software. You may use RSS
reader software to view alarms in real-time (depending on the update rate of the RSS reader).

4. Download Opera Internet explorer. Opera is recommended due its built-in RSS functionality. Once
you define your email account in Opera, a new menu named "Feeds" will be displayed in Opera. To
create a new feed in Opera, click on "Feeds »Manage Feeds...". Then click on the "New" button. See
below how alarms are displayed in Opera.



Viewing alarms in Opera using RSS feed

Below you can see how alarms are displayed in Opera. You can sort alarms, filter alarms and mark alarms
with different labels. For example: "Important” or "To-do".

In addition, you may forward alarms via email. Click on a specific alarm, use the mouse right click and then
click on "Forward".

Double-click on any alarm to view the alarm snapshot link. Click on the link (see below) to view the alarm
snapshot.

The link to the alarm snapshot

1.418.03.2005 11:18:49 Start alarm Water injection valve is opened - Opera

File Edit “iew Bookmarks Feeds  Tools  Help

temperature controls » www tempoo.com Temperature Controllers
In stock or made to order 800 323-6859 PID Profile & Process Cond

o . =
[ ] Newpade | & Mew-York hotel - building. . Ld 1£]

New-York hotel - building management system ~ (+unread, 4 total)

@ Read )( Delete |L| Label = Gyview = | quick find -
From: "Mew-york hotel - building management system” <=

Subject: 18.03. 2005 11:15:49 Start alarm Water injection valve is opened
Date: Tue, 10 May 2005 17:38:37 +0200

Start alarm - Water injection walwve iz opened

htep://wwy. controlsee. com/Files/Cellular English/Alarm-20050315-111545-1 eml.htm

Alarm list in Opera

1./New-York hotel - building management system - Opera . o ]
File Edit Wiew Bookmarks Feeds Tools Help

Temperature Controllers = v SutomationDirect.com Temperature Controllers = «w v jumo.us

Conditioners, Timer Relays & More. Incredible Savings - Fast Shipping| PID Profile & Process Controllers Buy any DIN size online or call us.

(] Hew psge € I | £ 18.03.2005 1111849 5k, [ |2 LG ME-Snapshet Ld ]

New-York hotel - building management system - (4 unread, 4 total)

@Read x Delete = |L|Label - Ooview ~ |G quick find w7
* Fram Subject Sent [ Lakel
* ' | New-York hotel - building management sys... ﬁ 18.03.2005 11:24:35 Start alarm Reactor C12 - temperature to.. Tuesday... 1...

New-York hotel - building management sys.. ¢85 18.03.2005 11:22:07 Start alarm Transfer pump is started Tuesday... 1...
#* ' | New-York hotel - building management sys... 18.03.2005 11:18:59 Start alarm Conveyor speed is boo slow Tuesday... 1...
#* ' | New-York hotel - building management sys... ﬁ 18.03.2005 11:18:49 Start alarm Water injection valve is opened Tuesday... 1... =1 Im.

From: "Mew-York hotel - building management system' <> Display all headers
Subject: 18.03.2005 11:22:07 Stark alarm Transfer pump is started
Date: Tue, 10 May 2005 17:38: 37 +0200

irite & quick reply to "Mew-York hotel - building management sywstem” <> here -




Alarm snapshot window in Opera

4 jU.C.ME-Snapshot - Dpera =100 x|
File Edit “iew Bookmarks Feeds Tools  Help

temperature Controls = e tempco.com Temperature Comtrollers = vy jumo.us
In stock or made to order 500 323-6859 PID Profile & Process Controllers Buy any DIH size online

U Hew page @New-\"orkhotel-building...[:;Il £ 18.03.2005 11:18:49 5., ] € [he

o E = by ‘4&} s’ | & hittps fwnen cantrolsee, com/Files/Celular_Englishialarr | = | Googlesearch = 66

= Start alarm 18.03.2005 11:18:49
= Water injection valve is opened
= Category - Reactor

|Valve is Opened

Water level Tank A 12 meters
Water level Tank B 25 meters
|Water level Tank C 37 meters
|Reactor temperature 89 celsius

< B @ @O

Frewv Mt Felun  Hema Ve ﬁdn‘.s 5§m % ‘ [Pump Station 8-75 RTU_T' TW”@?'WB“
|

Pump#2]  [Pumpi ]

20703.4| Heurs 76227 | Hours T44d4.4| Hours R82.97
12187 | Starts 6112 | Starts m Starts -
Tatalized Flow MG

1654.86

Waetwell Level FT.
7.70 n




Mechanisms of U.C.ME

U.C.ME's Queues

U.C.ME maintains several queues:
e Phone/Fax queue
e SMS queue
e Loudspeaker queue

Each queue can hold up to 200 items. When an alarm is generated, U.C.ME adds items to the appropriate
queues. Different threads in U.C.ME are handling the different queues. Each thread deletes an item forma
queue and trying to complete the task — delivering an SMS, playing a voice message etc...

If a task terminates unsuccessfully, the item will be returned to the queue. This process will continue until the
“Number of retries” defined in the U.C.ME configuration program will be reached.

Phone calls - picking up the phone
Once the call is answered, U.C.ME waits for non-silence detection. This ensures that the phone’s handset is
near the person’s ear. Therefore, you must say “Hello” (in any language) to here the welcome message.

Phone calls - Playing the welcome message
The “welcome message” is played only when U.C.ME waits for a password. If the “Wait for password” field is
not set, U.C.ME will not play the “welcome message” and will play the alarm voice file immediately.

While the “welcome message” is being played, the person who receives the call can start enter his
password. The password may be combined from 1 to 6 digits.

It is recommended that the password will be combined from at least 3 digits.

After the password has entered, you may click on the “#” key to inform U.C.ME that your password was fully
entered. When U.C.ME gets the “#” key is plays the alarm voice message immediately with no delays.

U.C.ME gets the password and checks if it is a correct one. If not, you will here the “Bad password”
message, and you may try one more time. If the password is incorrect again, U.C.ME will terminate the call,
and try again.

Phone calls - playing the alarm voice message
After a correct password you will hear the alarm message. If you missed part of the message and you want
to replay it, click on the “*” key at any time, and the message will be replayed.

Sending e-mail

To send e-mail, U.C.ME requires that the Advanced Direct Remailer program will be running in the
background. Make sure that this program is running and automatically loaded at startup.

In addition, you have to ensure that your PC is connected to the internet.

Sending fax
To send fax, U.C.ME requires that the Dialogic board installed in your PC will support fax.



Troubleshooting

The following sections address some of the most common problems encountered while using this U.C.ME.
Please check the following list of Problems and Solutions before contacting Control-See support.

Problem: U.C.ME run-time service fails to load.

Solution:

1. Check that the U.C.ME service startup type is set to Automatic. Use the Windows
Start» Settings» Administrative Tools» Services menu to view the service properties.
2. Make sure the OPC server can run as a service. If not, U.C.ME can't run in service mode.

Problem: Plug is missing Dialog box is displayed. U.C.ME is running in demo mode.

Solution:
1. Make sure that the U.C.ME plug is connected to the USB port.
2. Check that Aladdin's Hasp driver is installed. Open a command window and type "HINSTALL
/info". See below the window containing the driver information. The HINSTALL.EXE program is
located in the BIN directory of U.C.ME. Type "HINSTALL /i" to install the driver.

X

HASP Device Driver installation skatus:

Hardlock Driver is installed also

Version installed: 4,95

Driver Path: VP VWINNT swstem32 drivers\Haspnt. sys
Installation date:  Movember 23, 2004

Computer name:  x86

Computer bype: IBM cornpuker

Port Mode: Auko
kKey Search: USE-Parallzl
LPT1: 0x373

3. Check that the maximum number of alarms allowed by the U.C.ME license is not exceeded. In
this case you will have to upgrade your U.C.ME license.

4. Check that a standby plug is used. When a standby plug is used, you must define the application
as "Master-Standby" (see Configuration — Settings window).

Problem: U.C.ME configuration fails to start. The following message is displayed: "Note: The
Dialogic drivers are not installed!"
Solution:

Make sure that the Dialogic drivers are installed. Use the Intel/Dialogic drivers CD to install.

Problem: The following error message is displayed: "[Error] Can not open dialogic device!".

Solution:
Make sure that the Dialogic service is defined as startup type -"Automatic”.



Problem: Unable to move to folder - 'folder_name'!

Solution:

The application_folder_name may be passed to U.C.ME Run-Time module as a parameter. For
example, "UCME-RT C:\Program Files\Control-See\UCME-OPC". Make sure that this is a valid path.

Problem: The following error is displayed: "[Error] Hi-Phone Init Device failed! Please check that
the device is properly connected to your PC."
Solution:

1. If you are using the Hi-Phone telephony USB device, make sure that the Hi-Phone drivers are

properly installed.
2. Make sure that the Hi-Phone device is connected to your computer.

Problem: The following error message is displayed: "OPC client DLL failed to start (x)!"

Solution:

1. Make sure that the OPC server defined in U.C.ME is running properly.
2. Tryincreasing the "Initialization timeout" defined in the settings window.

Problem: The following error message is displayed: "Errors detected during OPC client
startup(x)!"
Solution:

Make sure that the OPC tag names defined in U.C.ME are valid. You may look at the file OAl.log for
further details.

Problem: The following error message is displayed: "[Error] DDE client DLL failed to start!"

Solution:

1. Make sure that the DDE server name defined in U.C.ME is correct.
2. Make sure that the DDE server software is loaded before U.C.ME.

Problem: The following error message is displayed: "Error! GSM modem is not responding(1)
Modem initialization stopped"”

Solution:

1. Make sure that the modem's power is ON.

2. Make sure that the modem is connected to the same port defined in the SMS protocol window.

3. Make sure that the SIM card is installed in the modem.

4. Open the Hyper Terminal program and try send the AT command to the modem. Use the
following parameters to connect to the modem: "9600,N,8,1".

5. If you fail to communicate with the modem check your communication cable.

6. If the communication cable is OK, try to check if the modem is defined as auto-baud rate. Try

connecting the modem at different baud rates until you get a response to your AT commands.

7. To remove the "auto baud rate" use the following AT command: AT+IPR=9600;&W . After you
type this command, close the Hyper Terminal program and run it again, this time with the baud
rate of 9600.



The Dialogic Voice Sample Program

The Dialogic Voice Sample Program can be used to Open a voice channel, play and record voice files. To
operate this program click on the “Start#” key, then click on “Programs”, “Dialogic Development Package”
and “Voice Sample Program”. The following window will be displayed.

Function Options Window

Click on File» Open to open a voice channel. The following window will be displayed.

Select Channel E

Select the channel you want to use. Use dxxxB1C1 for Channel 1, dxxxB1C2 for channel 2 etc. Click on OK.
The following window should be opened.

[# Sample Dialogic Yoice Application
File Function Options Window Help
B dooB1C1

Device opened.




Click on “Function »Dial”. The following window will be displayed.

Enter Digits:

& Cancel

[C Perfect Call Analysis

Enter the phone number you wish to call. Click OK. The following window should be displayed.

[ Sample Dialogic Voice Application
File Function Options Window

B doxB1C1
Dialing 5732528... Done!

Now you can play or record any file. Click on “Function »Play vox” or “Function »Record vox” to play
and record voice files. Record your voice after the beep sound. To end recording, click on any of the
phone’s keys.

Following a successful recording, the following window will be displayed.

fE Sample Dialogic Yoice Application

File Function Options Window

E dooB1CI
Recording to VOX file: CMtmpitemp.VOX... Donel




System voice files

The U.C.ME software package uses several reserved voice files for internal use. You can record these
system voice file with your voice, but try to keep the message context as is. U.C.ME searches for these files

and won't run if they are not found.

File name Voice contents
ACTION "Please enter action code.”
ACTNOFND "Action code does not exist!"
ALREND "Alarm ended:"
ALRSTART "Alarm started:"
ACK "Acknowledge alarm"
AND The word “AND”. Use for:
“The time is 10 AND 15minutes.”
ARERESUME "Dialing activity is resumed."
ASUSPEND "Dialing activity is suspended.”
AT The word “At”. Used for:
“Fire alarm! at February 2, 12:35."
BADPASS "Wrong password, please try again."
CANCEL "The operation has been canceled."
CURVALIS "The current tag value is..."
DEFACT “To perform..."
DELALRTS "To delete alarms log file press ‘9. Other key to end.”
DIALNNnN "Dial in voice files, where nnn is the defined
action code”
ENDOFCAL "To verify END-OF- CALL please type on #"
FAILED "The operation failed."
FOR “For..."
GETALRNO "Please enter alarm ID number."
GETKEY "Press 1 to confirm or 0 to exit."
GETTIME "Please type the desired time. (0000 to 2359)."
GETVALUE "Please type the desired tag value. To end, press "#"."
GOODREC "Your voice message has been recorded.”
ILLEGAL "lllegal"
MINUTES The word "Minutes”. Used for:
“The time is 10 and 25 minutes”
MINUS "Minus"
MISSFILE "Missing voice file"
MOREINFO "Playing alarm additional information"
NOALERTS "No alarms found."
OUTRANGE "The chosen value is out of the tag’s limits.”
POINT "The word "point". Used for: "The value is 1 point 5."
SHUTDOWN This is a sound file is played at the end of the call.
SUCCESS “The operation succeeded."
THEVALIS "The chosen value is..."
VERIFY “You have choose to perform the following action."
WELCOME "Hello, this is a U.C.ME message, please enter
your password to get the rest of the message."”
WVRECORD "Please record your voice after the beep.
To end recording type on any key on
the phone's keypad."
0-59 60 voice files which represents the values 0 to 59.

These files are used for date and time stamps.



JAN - DEC

MISSFILE

SERVEROF

ACKOREXI

MISSFILE

12 months voice files
(jan,feb,mar,apr,may,jun.jul,aug,sep,oct,nov,dec)
which are used for alarms’ date stamp.

“Alarm voice file is missing."
"Attention! Your server application is down!

You must re-load your server application and U.C.ME."
“To proceed to the next alarm press 1,to exit press O,
to acknowledge alarm press 9."

“Alarm voice file is missing”



Quick user guide for the phone recipients

This chapter intends to guide you (the phone call receiver) how to react when
U.C.ME places a call to you.

”

Usually when you pick up the phone’s handset, you start with the “hello” or “This is George speaking
greetings. U.C.ME waits for these greetings and will play the “Welcome” message after the analyzing the
voice from the other side of the line.

When you here the “Welcome” message you can immediately enter your password. You don’t have to wait
until the “Welcome” message is ended. Enter your password, and when you are done, click on the # key.
This key indicates that you have finished entering your password. By entering the # key, you will get the next
voice message with no delay. If you won’'t enter the #, you may wait few more seconds until the next
message will be played.

Note: The “Welcome” message is optional and may be omitted. This is set by the engineer who designs
the U.C.ME application.

While the alarm voice message is being played, you may click on the = (asterisk) key to instruct U.C.ME to
replay the voice message. This key should be used if the voice message was corrupted.

After the receiving the voice message you may click on any key to inform U.C.ME that you got the message.
In this case U.C.ME will play the next message with no delays.

After receiving the alarm message, you may be requested to click on the # key to acknowledge that you have
received the call with no problems. If you were asked to click on this key and you didn’t, U.C.ME will re-dial to
this phone number again.




The 'Remote Upgrade Service' utility

U.C.ME may be upgraded remotely via the RUS utility. To operate the RUS utility click on: Start » Programs

» Control-See » U.C.ME » RUS

The following window will be displayed:

e

A Control See Software Solutions Ltd. = |

Filz  Help
Key Type |l
~Client Operation:
1D Mumber I—
Code
Rezult
Get D Perfarm Update | Get Plug Info. |

Cloge |

Click on the "Get ID" button, to retrieve the plug ID.
Send this number to Control-See together with your
upgrade order. Control-See will provide you the
license code. Copy this license code and paste it into
the code area.

Once you have the license key file (*.LIC) click on
"File »Load License File..." menu item. Select the
license key file. The license key will be displayed in
the "Code" window.

Click on the "Perform Update" button. The plug
should now be upgraded.

Click on the "Get plug Info." button to view the plug information. The following window will be displayed.

Eal 1).C ME Plug information

Yersion ||45

Alarm count |5|]—
Date Limit [#r-
Humber of Clients Iﬂ—

rFeatures

¥ “aice

[ SMS

¥ Fax

v Email

v Multimedia

v &larm Snapshot
v Standby plug

U.C.ME

Unified Control MEssaging

ok

x|




Purchasing the Dialogic/Intel board

You may purchase the Dialogic board from your local Dialogic sales office (See below).

Dialogic Internet web site

For latest updated files and drivers from Dialogic please log on to
http://www.intel.com/network/csp/trans/dialogic.htm

Or

http://www.intel.com/

Purchasing the Hi-Phone telephony device

You may purchase the Hi-Phone telephony device via Way2Call's web site:

http://www.store.communitech.com/web/way2call/default.asp



http://www.store.communitech.com/web/way2call/default.asp
http://www.intel.com/
http://www.intel.com/network/csp/trans/dialogic.htm
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